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Attention all Mac users 
 

The first step for all Mac users who don’t have a three button mouse 
and/or a thumb wheel on the mouse is: 
 

1.! Go under Edit menu 
2.! Choose Preferences 
3.! Click the Input tab 
4.! Make sure there is a tick in the check boxes for “Emulate 3 Button 

Mouse” and “Continuous Grab”. 
5.! Click the “Save As Default” button. 

 
This will allow you to navigate 3D space and move objects with a 
trackpad or one-mouse button and the keyboard. 
 
Also, if you prefer (but not critical as you do have the View menu to 
perform the same functions), you can emulate the numpad (the extra 
numbers on the right of extended keyboard devices). It means the 
numbers across the top of the standard keyboard will function the same 
way as the numpad. 
 

1.! Go under Edit menu 
2.! Choose Preferences 
3. Click the Input tab
4.! Make sure there is a tick in the check box for “Emulate Numpad”. 
5.! Click the “Save As Default” button. 



 
 
 

BLENDER 
BASIC SHORTCUT KEYS 

 

 



 

 
 
 

OBJECT MODE SHORTCUT KEYS 
 

 



 
 

 
 
 

EDIT MODE SHORTCUT KEYS 
 

 
 



The Interface 
 
The interface of Blender (version 2.8 and higher), 
 

 
 
is comprised of: 
 
1. The Viewport 
 
This is the 3D scene showing you a default 3D object called a cube and a large mesh-like 
grid called the plane for helping you to visualize the X, Y and Z directions in space. And to 
save time, in Blender 2.8, the camera (left) and light (right in the distance) has been added 
to the viewport as default. 
 



 
 
2. The Tools palette 
 
If this is not visible, press T. The Tools palette is where the most commonly used tools are 
located. A significant improvement from earlier versions in which you had to know the key 
to press, now Blender 2.8 and higher will show you another way that is quick and efficient 
visually speaking. In whatever mode you are in, the following tools will always be visible 
while the viewport for the 3D scene is shown: 

 

 

 
Select box 
 
Cursor 
 
Transform 
 
Move 
 
Rotate 
 
Scale 
 
Annotate 
 
Measure 



 
3. The outliner 
 
The outliner panel in the top right is the place for displaying all the objects in your 3D 
viewport, including camera and lights, as well as materials and animations: This is 
organized under the broad term “Collection” as opposed to “Layer” in previous Blender 
versions. You can have any number of multiple collections to hold different parts of a 3D 
object or complete 3D objects. The collections can contain independent cameras, lights, 
materials, animation sequences and so on as needed for you to visualize the object 
contained in the collection. 

 

 
 

4. The Properties panel 
 
The Properties panel in the lower right contains more specific information about the objects 
in terms of their properties. By properties we mean things like the exact location of a 
selected object in 3D space (i.e., x-, y-, and z-coordinates), scale or size of the object, 
whether there are any materials and textures applied to the object’s surface, as well as 
general information about rendering and other functions. The default Properties panel 
shown is the Render Panel): 



 
 

5. The time line 
 
The time line is the place to animate your 3D objects and their properties within your scene. 
If you don’t need to see this, press Ctrl Up Arrow to hide it: 
 

 
 



User interface resolution scale 
 
Having trouble seeing the small writing in the panels? Fear not, as you can now put your 
cursor inside a panel, press Ctrl and the middle mouse button and you can drag the cursor to 
enlarge the User Interface of that specific panel. If you want all the user interface elements 
to enlarge, go to Edit!Preferences. Under the Interface section you will see the option to 
change the Display’s resolution scale. Maximum is 2 times the default size. Most people 
find it comfortable at 1.4. 
 

 
 
NOTE: Blender is one of the few, if not only, 3D package that allows the user interface to 
be enlarged.



Viewport Manipulations 
 

Splitting and Joining the Viewport 
 
 
Re-sizing the viewport 
 
The first step you need to know is how to change the size of the viewport. For this to be 
achieved, you must move the cursor to the edge of the viewport until it changes icon. The 
new icon should look like two parallel vertical lines and a horizontal line with two arrows at 
each end. This is the icon for moving the viewport, and to split the viewport. Without 
pressing any key, press the left button on the mouse and move the icon. Viewport changes 
size. 
 

 
 

Notice the cursor icon change at right edge of viewport next to the Outliner. 
This is the moment you can re-size the viewport. 

 



Splitting the viewport 
 
The next step, and considered essential later when you are modifying the shape of any 3D 
object, is knowing how to split a viewport. Why? Because you need to see the same 3D 
object in different viewports so you can quickly create your 3D models from different 
positions in space all at the same time. It helps to rapidly shape your object in the right way, 
and minimizes a lot of navigating the 3D scene to see the object from different positions, 
especially for minor changes. 
 
To split the viewport, repeat the first step above of re-sizing the viewport until you see the 
icon change. Now right click the mouse button (for PC users) and drag with the mouse to 
create a second viewport. 
 
For Mac users, there is another way. Move the cursor to the corner of the viewport (any 
corner will do). The cursor changes to a plus (+) sign. Now drag the icon in the direction 
you want the viewport to split. 
 

 
 



Joining the viewports 
 
Joining is just another name for hiding one of the extra viewports. To join viewports into 
one (or make one disappear), choose the viewport you want to keep and go to the corner of 
it and adjacent to the second viewport you want to hide. Icon of plus (+) sign appears. Move 
the icon into the viewport you want to hide. If the viewport is large enough, a large arrow 
will appear showing the direction the preferred viewport will expand to. Let go of the 
mouse button. 
 

 
 
Alternatively, place the cursor right over the line splitting the viewports and press the 
Command key followed by clicking the right mouse button. A small pop-up window will 
give you the option to Join Area (the same as joining two viewports into one). 
 
NOTE: If you accidentally shrunk the second viewport until it stops and will not go any 
further even though its menu still appears, then go back to the corner of the viewport you 
want to keep and get the plus (+) sign icon showing again. With the mouse button pressed 
down, move the icon a little bit further into this second viewport’s menu region. Let go of 
the mouse button. 



Adding a background image to the viewport 
 
A useful feature to have in Blender is the ability to recreate, or place certain 3D objects in 
position with, say, a photograph or 2D drawing. For the photograph or drawing itself to 
appear in the 3D scene, you can either create a flat surface mesh 3D object and place the 
picture on its surface. Or you can try this method of adding a background image to the 
viewport: 
 

1. In the Add menu, look for ImageàBackground, or ImageàReference. 
2. Find and select the image file. 

 
Please note that for accuracy (and to see the picture) use orthographic projection and Top 
View in the View menu prior to adding the background image. 
 



Are you in object or edit mode? 
 
Another important concept to learn in 3D modelling is knowing whether you are in Edit or 
Object mode. 
 
The difference is that Edit mode is where you sculpt and shape your 3D objects. Whereas 
Object mode allows you to select entire objects and manipulate them (mainly to move, scale 
and rotate them for instance). Object mode is also the place to adjust the position of the 
camera and lighting so you can render the scene (i.e., with textures, shadows and everything 
else). 
 
To switch between Edit and Object modes, press the Tab key (NOTE: the cursor must be in 
the viewport for this to work). Alternatively, choose Edit or Object mode from the pop-up 
menu. 
 

 
 
NOTE: Selecting the entire object in Edit mode has improved in Blender 2.8. It is now 
possible to use the mouse to drag a selection area around or part of a 3D object. Then 
choose SelectàSelect LinkedàLinked, and the entire object is selected (without having to 
press A to select other 3D objects). 



 
Navigating 3D space within the Viewport 

 
 
A major advancement in Blender 2.8 are icons in the top right corner of the viewport dedicated to 
navigating the viewport. They appear like so, 
 

 
 

From left to right you have: 
 

1. Orthographic projection or perspective mode. 
2. View through the camera. 
3. Translate. 
4. Zoom. 
5. Rotate (the big fancy thing looking like a chemical molecule). 

 
Having these icons has made it radically easier for laptop users (and especially for users new to the world 
of 3D modelling) and simplifies the workflow for professional users when they need to move around in 3D 
space. 
 
Of course, for those die hard Windows-centric users who prefer the mouse and keyboard buttons approach, 
try the following: 
 

Function To Apply 
Rotate With the cursor in the viewport, move 

two fingers across trackpad. 
 
 

Translate With the cursor in the viewport, press 
Shift key and move two fingers across 
trackpad. 
 

Zoom in or out through 3D 
space 

With the cursor in the viewport, press 
Ctrl key and move two fingers across 
trackpad 
 
OR 
 
Press Ctrl followed by + or – keys. 
 
NOTE: Placing cursor in the other 
panels, pressing Ctrl key, and moving 
two finders across trackpad, will zoom 
the panel in or out. So for those users 
who feel they must squint at the small 
user interface in other 3D apps, you will 
no longer have to in Blender. 



Zoom out and tanslate to 
see all objects in the scene 
 

Shift C 

 
 
Viewing models from specific positions in space 
 
Another essential aspect of modelling 3D objects is knowing how to view your objects from 
specific positions in space, such as from the top, front or side, and/or whether to view the 
models in perspective or orthographic projection. To specify the view, choose what you 
want from the View menu as shown below:  

 

 
 

NOTE: Sometimes when adding the first camera into a 3D scene how the options to 
transform and zoom the viewport may seem like they do not work. They actually do. Just 
make sure the camera lens is set to 35mm, and keep zooming back until the 3D object is 
able to move away. This is the time when the other navigation buttons will suddenly appear 
to work. 



The basic 3D scene explained 
 
Of course, no 3D scene is ever complete without at least one object placed somewhere in it. 
By default, Blender displays a cube (which in really older versions may be looking at you 
directly from the front in what looks like a square on 2-dimensional space, or is at an angle 
to show the 3-dimensional nature of the object and space in more modern and up-to-date 
Blender versions). 
 
 
Controlling how 3D objects appear in Edit/Object mode 
 
To make it easier to visualize, the object will be roughly shaded (and would appear to be lit 
from any direction independent of the lighting objects you may have added) to give a sense 
of a solid object in space. Since computers are relatively fast in the processing speed, this 
should be fine. However, should the number of objects in 3D space increase considerably 
and everything feels slow to move around, change the appearance of the objects to 
wireframe by pressing the Z key. You will be shown options of Wireframe, Rendered, 
Solid, and LockDev mode. The default is Solid. Choose Wireframe to show a wire outline 
of your 3D objects. You should notice a dramatic improvement in speed when navigating 
the viewport. 
 
NOTE: In the coming years, computing power will reach a point where Wireframe will 
probably become redundant. For now, the option is there for those with less grunt under-
the-bonnet of older computers. 
 
In LockDev mode, this is a new feature of Blender 2.8 to help you use a new render engine 
called Eevee that is faster to render by allowing you to specify which features you want 
rendered and shown, all while in Edit/Object mode. It is designed for speed and to help you 
better visualize the 3D scene where accuracy and applying all the features are not necessary. 
It is very similar to the way the Element 3D plug-in for After Effects works in that you have 
to turn on specific features such as glowing effects, add shadows, and all the rest. If you do 
not need them, you can turn them off, and Element 3D can more quickly render and move 
3D objects. 
 
 
The Merging of Layers with the Outliner Panel 
 
Another major advancement in Blender 2.8, and an alternative means of speeding up the 
process of modelling and moving 3D objects in space, is the Layer concept. 
 
In older Blender versions, you would store 3D objects in specific layers looking like 20 
pigeon holes where you can turn on (with the appearance of a golden sphere) or off these 
layers. By default, the cube will appear in layer 1 as identified by this ancient and quirky 
user interface element seen in Object Mode: 
  



 
 

In Blender 2.8, the Outliner panel has now become your unlimited Layers for storing 3D 
objects as well as the place to name 3D objects, including lights and cameras. Furthermore, 
the layers can be grouped under a general name called Collections. A collection can have a 
group of sub-collections containing multiple objects in each one. The advantage of sub-
collections is that you can select the sub-collection and all the objects contained with it can 
be highlighted and manipulated in the same way. And each sub-collection can represent 
parts of a 3D object that you want to focus on and get right before adding all the other sub-
collections to form the complete 3D model. 
 
In terms of organizing things, you can drag and drop sub-collections into different 
collections. Alternatively you can press M for move (with the cursor in the Outliner panel) 
and a pop-up menu will appear to allow you to specify the sub-collection where you want 
an object to be moved to. 
 
Or if you need to duplicate an object and paste into another collection, click the collection 
name or specific object within the collection in the viewfinder, copy it, select a different 
collection, and paste it. 
 
You can also join objects together to act as a single mesh object in the collection. To do 
this: 
 

1.! Go into Object mode. 
2.! Select two or more sub-collections in a given collection containing mesh objects. 
3.! Move cursor into the viewport. 
4.! Press Ctrl J to join and make as one object. 

 
The joined single object will appear in one sub-collection and the other is deleted. 
 
NOTE: Ensure curves (such as texts) are converted to mesh. 
 
To separate the object into individual mesh objects: 
 

1.! Select your mesh object from the Outliner panel. 
2.! Go into Edit mode. 
3.! Select from the viewport menu Mesh!Separate!by loose parts, or just Press P and 

choose by Loose Parts
 
On the far right at the end of each layer within the collections, there is an Eye icon to make 
visible or hide the object. And from there, you can turn on or off the layers representing 
collections, sub-collections and the layers holding parts of an object.
 



This brings up another big advantage of turning off layers or collections: you will 
dramatically increase the speed of manipulating 3D objects and navigating the viewport. 
 
Also, if you are in the business of animating parts of a 3D object, you will quickly see the 
benefits of collections etc. By turning on and off the layers in the Outliner panel, you can 
isolate a particular model for animation. Nothing else has to get in the way as you prepare 
the animation sequence for the component you are seeing. When you are finished, turning 
on the other layers will complete the picture and show the animation taking place as you 
expect. 
 
 
Changing colour of primitive objects added to the viewport 
 
One more thing: if you do not like the grey shading colour of the 3D objects you add to the 
viewport from the default primitives and other objects, you can change the colour by 
clicking the far right button and going into MatCap. 
 

 
 
Click the sphere and from there you can select a colour or material. All new objects you add 
to the viewport will have this colour. 
 
Again, all part of making it easier for you to visualize and see the 3D scene. 
 
Okay. So let us explain the basics of manipulating objects. We begin by learning how to 
select, delete and add a 3D object.



 
 



Manipulating Objects in 3D space 
 
 

Object Selection 
 
Before you can manipulate any 3D object, you have to know how to select it, or parts of it. 
In fact, your ability to select things is probably one of the most important skills to master 
properly, and it is the same for any 3D modelling app you will ever encounter and use. Each 
app is a little different in the approach to selecting parts or entire 3D objects. You will have 
to get to grips with the object selection capabilities of the apps. In Blender 2.8, it is no 
different. However, its selection capabilities are now quite sophisticated as well as being 
remarkably easy once you know which keys to press or which menu selection to choose 
from in the Select menu in both Object and Edit modes. Much of what you find in Blender 
has been the culmination of many years of experience by people who have used Blender, 
and you can benefit from this expert knowledge of how to do things easier and with the 
flexibility you are likely to require when manipulating your 3D objects. Blender has truly 
come of age. 
 
Just as a hint, an object or parts of an object that appears selected in Blender will turn 
orange. This is your first important thing to remember, and the easiest. No selection feature 
can be useful unless you can see what you have selected. 
 
Things begin to get more interesting when you realise Blender can allow selecting of a 
vertex (or point where edges intersect), an edge, or a face. Or you can select any number of 
points, edges or faces. Furthermore, there are special menu commands to simplify the task 
of selecting enough of an object based on certain criteria. For example, you can select only 
those objects that have a particular material attached to them. Or you can select part of a 3D 
object and tell Blender to grab additional faces of that part without selecting everything 
else. 
 
NOTE: If you have trouble selecting an object or parts of it because Object mode is the only 
mode you can choose, make sure you have not selected a lighting source object or camera 
object. You will see this in the Outliner. Make sure to click on the object you want to edit in 
the Outliner. And indeed, you should make full use of the Outliner panel to separate 
components of a 3D model for quicker independent control and selection without affecting 
other objects. 
 
The following table shows the various ways you can select a 3D object: 
 

Function To Apply 
Select or Deselect all 
objects 

Press A to select all object. To deselect, 
click in empty space anywhere in the 
viewport. 
 

Select one object Move the cursor over the object and 
click with the mouse on the object. 



 
Alternatively, press B, move the cursor 
near to the object, click the mouse 
button, and drag the cursor until part of 
the object is inside the selected area. Let 
go of the mouse button. 
 

Select multiple objects Press the Shift key and select each 
object with the mouse. 
 

Select all faces on the 
visible side of an object 

For Mac users, press B, and use the 
trackpad or mouse to drag the cursor to 
specify an area containing part or all of 
the object(s) you want selected. Let go 
of the mouse button for the selection to 
take effect. 
 
Or press G C and run the cursor over the 
visible side of the object to select the 
faces. Press Esc to get out of the 
selection mode. 
 

Increase number of faces 
selected 

Press Ctrl + as many times until the 
entire object is selected. 
 

Select a Vertex only 1. Choose Vertex Select Mode by 
pressing the following button on the left: 

 
2. Move cursor to a vertex on the 3D 
object. 
3. With two fingers, touch trackpad 
once. 
 
NOTE: Press Option to select a closed-
loop (or ring) or full length edge. Also 
press the Shift key to select more edges 
and thus select faces. 
 

Select an Edge only 1. Choose Edge Select Mode by 
pressing the following button in the 
middle: 

 
2. Move cursor to an edge on the 3D 
object. 
3. With two fingers, touch trackpad 
once. 
 
NOTE: Press Option to select a closed-
loop (or ring) or full length edge. Also 
press the Shift key to select more closed-
loop or full length edges (but not faces). 



 
Select a Face only 1. Choose Face Select Mode by pressing 

the following button on the right: 

 
2. Move cursor to a face on the 3D 
object. 
3. With two fingers, touch the trackpad 
once. 
 
NOTE: Press Option key to select a 
closed-loop (or ring) or full length set of 
faces. Press the Shift key to select more 
closed-loops or full length faces as you 
require. 
 

Selecting multiple vertices Select Vertex mode, press the Command 
and Shift keys and select each vertex 
with your mouse. 
 

Selecting multiple edges Select Edge mode, press the Command 
and Shift keys and select each edge with 
your mouse. 
 

Selecting multiple faces Select Face mode, press the Command 
and Shift keys and select each face with 
your mouse. 
 

Selecting multiple vertices, 
edges and faces 

1. Press the Shift key to choose a 
combination of Vertex, Edge or Face 
Mode buttons. E.g., 
 

 
 
2. Two finger trackpad touch to select. 
 

Selecting a group of 
vertices, edges and faces 

Press B. Then press the mouse button 
and drag across the object and let go of 
the mouse button. 
 

Select object by material 
name 

1. In Object mode, select one of the 
objects with the material. 

2. In the viewport choose from the 
menu Select à Linked à 
Material, or use Shift L à 
Material. 

Select an entire object not 
geometrically linked to 
any other object 

You have to be in Edit Mode for this to 
work. Then you move the cursor over 
the object you wish to select, and press 
L. That object with all its vertices, edges 
and faces will be selected, so long as it 
is not linked geometrically to any other 



object. 
 
Furthermore, this technique is 
particularly handy when you need to 
separate objects and put them into 
collections and/or layers within a 
collection of the Outliner panel. 
Something to consider for After 
Effects/Elements 3D users. 
 

Select a loop (or ring) of 
vertices, edges or faces 

Click a vertex, edge or face on the 
object, and choose SelectàSelect 
LoopàEdge Loop or Edge Ring. 

Deselect All Move cursor in the viewport to any 
empty area of 3D space. Click on the 
mouse button. All objects will be 
deselected. 
 

 
 

 
Joining selected vertices, edges or faces 

 
When you have mastered the art of selecting things, you can start to manipulate them in 
various ways. 
 
The first manipulation technique is taking one or more vertices, edges or faces selected in 
two separate objects, or an object with a missing face between the selections, and telling 
Blender to join them by creating an edge or face (whatever is appropriate). To make the 
join, press F. 
 
Now that wasn’t too hard. 
 
 

Filling in holes 
 
Filling in one face at a time is one thing. When you have literally hundreds or thousands of 
the little critters to fill in, it helps to know of a more efficient fill to fill a larger hole. 
Suppose as an example that you want to remove the following circular inset and make the 
surface smooth again. 
 



 
 
Use the Selection tool from the Tools palette (already highlighted in blue) to select the faces 
you will be deleting. 
 



 
 
Make it as square or rectangular as possible by choosing the Face selection button and 
selecting additional faces (or de-selecting them) until it looks roughly like so, 
 

 



 
Notice that some faces are not highlighted. Don’t worry. There is a quicker way to select 
those and delete them. For now, let’s delete what we have by pressing X. Choose Delete 
Faces. 
 

 
 
This is how it should look: 
 



 
 
Move the cursor over one of the faces you weren’t able to select before. Press L. Then 
delete the faces. Repeat for any stray points and faces. Next, select the Vertices button and 
select the top and bottom rows of vertices like so, 
 

 



 
Make sure the number of vertices selected for one edge of the hole equals the number of 
vertices for the opposite edge. 
 
Now all you have to do to fill the hole is press Ctrl F, and choose Grid Fill from the pop-up 
menu. The hole is filled. 
 

 
 
Another tool you might find useful is the menu command MeshàClean UpàFill Holes. It 
cannot handle large holes, but it excels in finding single or double adjacent missing faces on 
a mesh and automatically fills them in. Best thing of all, you do not have to be looking for 
the holes to apply this command. Just select the object, go into Edit mode, and apply the 
command. 

 
Here are some more manipulation techniques. 
 
 

Delete 
 
A fairly brutal way of manipulating things is to delete an object. If you are in a deleting 
mood or have the Al Pacino’s Godfather desire to see things disappear quickly and 
smoothly, do this: 
 

Function To Apply 
Delete Select the object or part of an object (in 



terms of vertices, edges and/or faces). 
Press X. A pop-up menu appears in 3D 
space. Choose how to delete, either by 
vertices, edges, faces or the entire 
object. 
 
In Object mode, press X. The only 
option given is to delete the object. 
 

 
Add a new Object 

 
The next step is act like God by creating (or adding) a default object into 3D space: 
 

Function Mode To Apply 
To add a new object 
(camera, lighting, sphere, 
cube etc) 

Object Press Shift A. Pop-up menu appears in 
3D space where you can select the 
object you want to add. 
 
Or, select the object you want to add 
directly from the Add menu. 
 

 

 
 



 
 
An extra useful feature in Blender 2.8 
 
An added bonus in Blender 2.8 is how the creation of a new primitive 3D object from the menu will also 
automatically display within the viewport a pop-up window to allow for precise information to be entered 
about the new object, such as object’s size, position, etc. This will only appear the first time the object is 
created. Afterwards, the pop-up window disappears and you will have to use the Properties panel to access 
this information. 
 
This new feature is useful if you need to position an object in a precise location and to set its size (or scale) 
with accuracy very quickly. It is more a workflow improvement rather than anything new. In other words, 
it is not something you couldn’t already do in previous Blender versions. The new feature merely saves you 
time. 
 



 
 

Object Transformation, Rotation and Scale 
 
Massive improvements in Blender 2.8 has seen a simplification of this area. You now have the Tools 
palette on the left looking like so, 
 

 

 
Select box 
 
Cursor 
 
Transform 
 
Move 
 
Rotate 
 
Scale 
 
Annotate 
 
Measure 

 
If you are learning Blender for the first time and want to see the names next to the icons, move the cursor 
to the edge of the Tools palette. It should change to a horizontal line with two arrows at either end. Click 
the mouse button and drag the icon to the right far enough until you see the Tools palette looking like this, 
 

 
 



Once you are comfortable in using the tools and understand what the icons mean, you can shrink the Tools 
palette to give you the extra real estate in the viewport. 
 
The other advantage of the Tools palette is that you can now click on a tool named Move, Scale and 
Transform and click on the object to select it, and you can immediately perform the function on the object 
by clicking again and dragging the cursor in certain directions to make those changes to the object 
straightaway 
 
Or, if you prefer the keyboard commands, they are as follows: 
 

Function To Apply 
Move an object through 
3D space 

Select the object. Then press G (for 
Grab) and use a single finger to move 
across the trackpad (or move the 
mouse). The object will move. When 
finished, touch again the trackpad, or 
press the mouse button. Object will be 
left in the new position. 
 
NOTE: Have you made a mistake and 
want to return to where you were 
before? Press the Esc key. If you have 
already moved the object, press 
Command (or Ctrl for Window users) Z 
to Undo last action. 
 

Move object through 3D 
space along the 
transformation axes (X, Y, 
Z) 

Select the object and pressing the Move 
tool or pressing G will show the X, Y or 
Z axes for the object (as red, green and 
blue respectively). Click on one of these 
axes to move the object. 
 

 
 

Rotate object Once the object or parts of the object is 
selected, click the Scale Tool, click 
again on the object and move the cursor 
with the mouse button down. 
Alternatively, press R, then move with a 
single finger across the trackpad to 



rotate the object. Touch the trackpad a 
second time to lock the new rotation in 
position, or press Esc to return to where 
you were. 
 

Rotate object around 
transformation axes (X, Y, 
Z) 

Select the object and click the Rotate 
tool, or press R. You will see coloured 
circles for the X, Y or Z axes. Move 
cursor over one of the circles, click on 
mouse button and rotate the object on 
that axes. 
 

 
 

Rotate object by an 
arbitrary angle 

Select the object or parts of it. Press R 
followed by the number representing the 
angle you want the object to be rotated 
by. For example, R-90 means the object 
is rotated by -90 degrees. 

Scale object Select object, an click the Scale tool. 
Click in the viewport and with the 
mouse button down, drag the cursor. 
The object will change size. 
Alternatively, press S, then move a 
single finger across the trackpad to scale 
the object. Touch the trackpad a second 
time to lock in the new size, or press Esc 
to return to where you were. 
 

Scale object along axes (X, 
Y, Z) 

Repeat as you would to scale an object 
previously, except this time place the 
cursor on one of the X, Y or Z axes. 
Click the mouse button and drag the 
cursor scale the object along the axis 
you have chosen.  
 

 



 
 

Show and Hide Object 
 

Function Mode To Apply 
Hide Selected Object(s) Edit Press H 

 
Show Object(s) Edit Option/Alt H 

 
Hide Unselected Object(s) Edit Shift H 

 
 
NOTE: The Hide Selected and Reveal Hidden pop-up window will appear, but is not entirely stable in 
version 2.8 beta. It seems to be stable after the first unexpected crash. So save the Blender file first (this 
should be done on a regular basis for beta software) prior to using the show and hide object features for the 
first time. 

 
Stretch and Extrude Object 

 
Function Mode To Apply 
Stretch an object in any 
direction 

Edit Select vertices, edges or faces. 
 
Press G. 
 
Touch trackpad with one finger and drag 
to stretch 3D object. 

Want to stretch an object 
but wish to lock the 
stretching to a particular 
axes 

Edit Select vertices, edges or faces. 
 
Press L G and either X, Y or Z. 
 
Touch trackpad with one finger and drag 
to stretch 3D object. 

Extrude vertices, edges or 
faces of an object 

Edit Select the vertices, edges and/or faces on 
the object. Press the E kay for Extrude. 
Use the mouse to drag the selection for 
extrusion. 

 
  
 

Duplicate Object 
 

Function Mode To Apply 
Duplicate (Unlink) Edit or 

Object 
Select object or part of an object and 
press Shift D. This will duplicate the 
selection including materials and texture 
data. You will automatically be taken to 
Grab mode where you can move the 
selected duplicate object away from the 
original object to any position in 3D 
space. 



 
VERY IMPORTANT: A common 
source of frustration for newcomers is 
how a duplicated object can continue to 
be linked in unexpected ways, especially 
when it comes to selecting just the 
duplicate object and not include the 
original object. To ensure the selection 
of a duplicate object remains unlinked to 
the original, press P to the selected 
duplicate object the moment it is 
duplicated and moved from the original. 
 

Duplicate (Link) Edit or 
Object 

To retain mesh object data linking such 
that any changes to the shape of an 
original object is automatically 
transferred across to the other duplicate 
object(s) and vice versa, press Ctrl/Alt 
D. 
 

Duplicate object to another 
Blender file (equivalent to 
copy and paste) 

Edit or 
Object 

There is no copy and paste commands in 
Blender. Use File-->Append, or File--
>Link to grab the object from another 
file and bring it across to a new Blender 
file. 
 

 
 
 

Change Object Handle Type for Bezier Curves 
 

Function Mode To Apply 
Create Vector Handles Edit If you have created a bezier curve and 

Blender draws the curve in a smooth 
rounded nature, you can change it to a 
sharp edged straight (or zig-zag) line 
effect (useful for creating lightning bolts 
etc) by selecting the handles at the end 
of the bezier curve and then press V. 
Select Vector. 
 

Extend bezier curve Edit Select centre handle at end of bezier 
curve, press Ctrl key down and start 
moving and clicking the mouse button to 
extend the curve. 
 

Convert 3D Bezier Curve 
to a Mesh 

Edit Press Option/Ctrl C and choose “Mesh 
from Curve”. 
 
NOTE: Useful to UV unwrap a 3D 
object and apply texture effects. To do 
this, select the mesh 3D object in Edit 



mode, press U and select Project from 
View. Rotate and scale up or down the 
projected mesh object to fill the grid so 
you can apply a texture effect correctly. 
Go into Texture and apply what you 
want. 
 

 

 
Changing the anchor / pivot point 

 
You may notice one thing when applying some of the manipulation tools. If you use the Rotation tool, for 
example, the object will rotate around a point in space. But what if you want the object to rotate around a 
different pivot point? 
 
Knowing how to change the pivot point is another important technique in 3D modelling. As you have 
probably noticed, manipulating objects in 3D space is quite hard. Sure, you can look at the objects on the 
screen. You can move the viewport to different positions to see the same objects from a different 
perspective and this can help to visualize the entire scene in your mind. However, when it comes to the task 
of physically manipulating the objects to do what you want and have them in the right spots, you have to 
know certain techniques to make the manipulations work in the easiest way. For example, if two objects 
are not positioned such that a straight line connecting their center of gravity is not lining up with the grid, 
moving an object in relation to another object is hard. You don’t have the simultaneous benefit of a third 
dimension to look physically from above unless you have 3D virtual reality goggles. You are working with 
a two dimension screen to see where an object has moved in 3D space and hopefully you have moved it 
right in relation to everything else. Not easy is it? Therefore, you have to know a few tricks to making life 
easier for yourself. 
 
The first concept you must learn is knowing how to prepare objects for the manipulation tool you will 
apply. Preparing means moving and/or rotating all objects to get them in a position so that you can benefit 
from the 3D grid pattern you are presented in the viewport, and to use the pivot point with its 3 arrows that 
appear from time-to-time—representing the X, Y and Z direction—to manipulate the objects in specific 
directions. Likewise, the circles for X, Y and Z axis that appear when you rotate object(s) are designed to 
lock in the rotation and simplify the manipulations along specific axes. By simplifying, say, the 
transformation or rotation of all or some of the objects to just three main directions, it is easier and quicker 
to get the objects to where they should be. You do not have to guess in which direction the objects went as 
you move them. It is not going to go off in a tangent and later spend time re-aligning the objects to the grid 
and in the right direction. 
 
The second concept is knowing how to change the pivot point so you can manipulate one object with ease. 
Here is the technique you need to know: 
 

1. Go to Object mode. 
 

2. Highlight the object you want the pivot point to be applied to. 
 

3. It is recommended that you get the cursor to touch the surface of the object, either on one of the 
faces, and edge or a vertex. So go into Edit mode. Deselect the object, click the Face, Edge or 
Vertex selection button, and click on the object. The face, edge or vertex will be selected. 
 



4. Click the 3D Cursor tool in the Tools Palette (just below the Selection Tool). Click on any part of 
where the selected face, edge or vertex is. 

 
5. To eliminate the guesswork of whether the 3D cursor point (which will become the means by which 

you can specify the pivot point later) is sitting on the 3D object and on the selected part, press Shift 
S. Choose “Cursor to Active”. 3D cursor moves to the selected face, edge or vertex. 

  
6. Go to Object mode. 

 
7. Choose ObjectàSet OriginàOrigin to 3D cursor. 

  
The pivot point has been set. So now, you can choose the Rotation tool and the object should rotate around 
this new pivot point. 
 
Much easier now, isn’t it? 
 
 

Snapping objects together 
 
A seldom used by beginners, but incredibly useful feature for the seasoned 3D artist is the ability to snap 
3D objects in a way that feels more natural as if the objects are solid matter that can touch the surfaces of 
each other. It also solves one of the biggest problems of 3D manipulations of trying to figure out whether a 
3D object is in the right spot to be considered “touching” the surface of another object. Otherwise, as you 
probably notice, the objects tend to pass through each other. 
 
To automatically rotate and snap to a surface of a 3D object, let us imagine we have the following scene: 
 

 
 
The aim is to get the base of the cone to sit precisely on the top surface of the cube. As the cone is on an 
odd angle and requires numerous steps to rotate and level the base and move it to the cube and then 
estimate the right amount for the objects to just touch each other, consider the following approach: 



 
1. You should be in Object mode. 
2. Enable the snapping option suing the following settings. 

 

 
 

3. Observe how the settings are for “Face”, Target is “Object” and we have turned on “Align Rotation 
to Target”. You need these settings. Finally, to physically start snapping objects to surfaces, there is 
a button at the top that looks like a horseshow magnet. Click on it. 
 

4. Next, select the cube. 
 

5. Go into Edit Mode. 
 

6. Deselect the cube. 
 

7. Choose the Face selection button. 
 

8. Select the top surface of the cube. 
 

9. Choose the 3D cursor tool from the Tools palette. 
 

10. Click somewhere on the selected face. 
 

11. Press Shift S. 
 

12. At the bottom of the popped up options, choose “Cursor to Selected”. This puts the 3D cursor point 
right on the surface. 

 
13. Go into Object mode. 

 
14. Choose ObjectàSet OriginàOrigin to 3D Cursor.. This also has the effective of moving the pivot 

point. 



 
15. With everything all set up, as soon as the horseshow magnet button is turned on, you can move the 

cone and the base of it will suddenly rotate and align to the top surface of the cube when it is within 
range of the cube. Once you see it aligned, you can let go of moving the cone. The cone is precisely 
touching the cube surface. 

 

 

 
This snapping feature can come in handy when snapping a copied segment of a 3D object and having it 
snap to another part of the object where the hole filling methods described earlier do not work and Blender 
is not quite smart enough to know what to do. 
 
NOTE: A pity Blender does not have a Clone tool for mesh to duplicate and paste faces to follow the 
general contour of an object. 



Modelling (Edit) Mode 
 
We come to the more interesting aspects of 3D. Once you have mastered the special 
manipulation tools to be discussed below, you will be able to create just about anything you 
want in 3D (and with a smile on your face too). 
 
 
Choosing a primitive object to work on 
 
To begin creating an object from your imagination or something in reality, use your mind to 
simplify the object to its fundamental form. What does it essentially look like in terms of 
the simplest geometrical shape or shapes. A dinner plate, for example, kind of looks 
roughly like a disk. A fish might look like an oblate spheroid. A soccer ball is obviously a 
sphere. A coffee cup might look more like a cylinder with a bendy cylinder thing-a-me-jig 
attached to the side called a handle. If something looks a bit complicated, try to break down 
the object into smaller components and focus on those parts to see the primitive shape that 
they roughly represent. Later, once the components are created, you can assemble them 
together to form the final object. 
 
Once you have decided on a broad shape for the object, you can select the primitive object 
supporting the shape you can see from Blender under the Add menu. Look under 
AddèMesh. 
 
Sometimes you would not bother re-creating an object because it is incredibly tedious and 
so common that it is just not worth your time. The letters of the alphabet is a classic 
example, and especially with the wide variety of font types available in the world. So to 
avoid re-inventing the wheel every time you need text in your 3D scene, the makers of 
Blender have been kind enough to add a feature called Text from the Add menu. Select 
AddàText. Press the Tab key to edit the text and change the letters or word to what you 
want. When you are finished, press the Tab key again to get back to the 3D environment. 
Easy. 
 
While it is great for common objects to be easily provided to you at the click of a menu 
command, in most cases, not everything can be at the tip of your fingers within Blender as 
you would like (bummer!). The makers of the app are not crystal ball gazers to know your 
every whim and need. It is these circumstances where you will have to create the object 
from scratch. And even then, the shapes can be intricate and tricky. It requires the ability to 
stretch things out, to bend them, to slot components together and merge them as one, or 
even to subtract one component from another to create sophisticated shapes and unique 3D 
objects. This is where Edit mode comes into its own. Of course, this isn’t the only mode of 
editing available to you. There is a more freehand way of manipulating 3D objects called 
Sculpt mode. 
 
 
 



Edit mode 
 
To begin changing the shape of a primitive (cube, sphere, cone etc.) or default 3D object 
(i.e., cube), you must go into Edit Mode. 
 
In Edit mode, you can select vertices, lines (or edges), or faces of the 3D object and 
manipulate them to create a new object. This approach is particularly useful for engineering 
and architectural designs where sophisticated but precise geometric shapes are required. 
 
For more freehand and free flowing manipulations of a 3D object, use Sculpt mode (see the 
next section for further details). 
 
To use the Sculpt mode and achieve the best results, you must increase the number of 
subdivisions on a 3D object you want to work on. By subdivisions, we mean number of 
vertices (or lines or faces). 
 
On the other hands, if a simpler geometrical shape is required, go the opposite way by 
reducing the number of vertices. 
 
 
Specifying the number of vertices 
 
The first decision you must make is whether your new primitive object (e.g., sphere, cube 
etc.) needs a geometric edit or a freehand sculpt. 
 
If you know the final object to be created will be a precise geometrical shape, or something 
with straight edges or fairly precise curves, use Edit Mode and adjust the subdivision of 
edges down to match the general geometry of your final model. For sculpting, such as a 
human face or create an animal body, you will probably want to increase the subdivisions 
by a reasonable amount. 
 
The best time to specify the number of vertices is the moment you create a new primitive 
3D object. Use the Add menu to add the object you want. A pop-up window in the viewport 
will appear, named “Add Cylinder”, “Add Sphere” or whatever, depending on your choice 
of a primitive shape. Click on it as this will provide you with the essential information 
about your object and change it quickly, including the number of vertices (and hence 
subdivisions). 
 
If, at any stage, you don’t see the pop-up, or you have been working on the model and 
decided further subdivisions are required, you can adjust the number of vertices later via the 
menu command EdgeàSubdivide. 



 
 
You can also reverse the number of subdivisions. You best option for this feature is as 
follows: 
 

1. Select object. 
2. Go into Edit mode. 
3. SelectàAll (or press A) to highlight all vertices and edges of the selected object. 
4. Under the Mesh menu, choose Clean UpàLimited Dissolve. 

 
Blender will intelligently decide where fewer faces can be used and where higher 
subdivisions are necessary (for highly curved edges). 
 

 
Selecting vertices, lines or faces 

 
In Edit mode, selecting a vertex, line or face is done by clicking one of these three buttons 
on the right next to the mode pop-up menu: 
 

 
 



In this example, we see that the Face selection button has been clicked (i.e., highlighted in 
blue). Next to it is the Edge button, and the one to the left of that is the Vertex button. 
 
Once you have selected the button, go ahead and click the vertices, lines or faces on the 3D 
object to highlight them. SPECIAL TIP: To quickly select the button on the keyboard, press 
1, 2 or 3. 
 
If you choose the Edge button and select enough edges to form a closed loop representing 
the smallest subdivision on the model, you are effectively highlighting a face. Hence the 
face will get highlighted. Likewise, highlighting two vertices adjacent to each other will 
select the edge. 
 
 

The process of modelling 
 

When you start modifying (or manipulating) a 3D object, you are effectively modelling the 
object. Therefore, to model the object to whatever shape you want, click on the object to 
highlight it. This will open up the option to select Edit Mode. 
 
The tools available to model your object in Edit mode is in the Tools palette on the left. 



 

 
Select box 
 
Cursor 
 
 
Transform 
 
Move 
 
Rotate 
 
Scale 
 
 
Annotate 
 
Measure 
 
 
Add cube 
 
Extrude region 
 
Inset Faces 
 
Bevel 
 
Loop cut 
 
Knife 
 
Poly build 
 
Spin 
 
Smooth 
 
Edge slide 
 
Shrink Fatten 
 
Shear 
 
Rip Region 



As you can see, you have all the standard tools to select, scale, move or rotate as expected. 
But you also have additional tools for manipulating the 3D object. The names of these 
additional tools are shown above. To apply any of these additional tools, you need to select 
some aspect of the object or the entire object, click the tool you want, and apply it to the 
selected region. 
 
To become adept in the best way to apply these tools, you should play around with them on 
another 3D object to see the effect. With practice, you will be comfortable and confident in 
applying these modelling tools. 
 
What’s available to edit a 3D model in a geometric way is already very sophisticated and 
you have just about all the essential tools you will likely need to design the 3D object you 
want. Perhaps about the only commercial 3D package that is more powerful than Blender’s 
own editing tools in terms of the number of tools to do this job and in an efficient way is 
3DS Max or Maya. 
 
To see how to model, watch this YouTube video: 
https://www.youtube.com/watch?v=jBqYTgaFDxU 
 
 

 



Sculpt Mode 
 
Fortunately, even Blender 2.8 is giving the makers of Maya a run for their money with 
features that are making other 3D apps look decidedly over-priced. One of those features is 
the Sculpt mode. This mode comes with a range of specialized tools designed to help you 
create and mold a more sophisticated free flowing shape to a 3D object as if you are a 
sculptor. 
 
In Edit mode, there is only so much you can do with manipulating individual vertices, lines 
and faces and applying extrude and other basic manipulation tools. Eventually for things 
like designing an animal body, human face, or something else, it is better to increase the 
number of vertices until the 3D object can be manipulated like plasticine using a separate 
set of specialist editing tools known as sculpting tools. This is where Sculpt mode comes 
into its own. 
 
The Sculpt mode is a much more flexible approach to getting the objects designed the way 
you want in a more freehand-style approach. There are more specialized and dedicated 3D 
packages out there that are heavily focused on this sculpting idea, such as Maya. But what 
you have in Blender is already quite advanced and with enough tools to rival those of the 
commercial players in this field. You would only use Maya if you need additional tools to 
create special and realistic 3D effects, such as fire and adding 3D hair on a human head or 
animal’s body. Still, give it time and it will not be long before Blender provides these 
effects as standard. 
 
So how do you sculpt something? You begin the process by getting a sphere (the general 
common shape for most things you will be molding into shape) put into 3D space, then you 
would select Sculpt mode: 
 

 
 

Use the View menu next to the mode selector menu to help you choose a view to make 
sculpting easier to perform and to see what you are doing. For example, choose Top view 
and remove Perspective view. 
 
Then start sculpting and molding this sphere into shape using dedicated tools for this task, 
such as Draw, Pinch, Smooth, Inflate, Flatten etc. You will find these tools in the Tool 
palette in the left pane. Press T if the left pane is missing. 
 



 



 
When you select a sculpt tool, you will have a number of options to choose from, including 
the type of brush, brush radius, and the level (or depth) of sculpting the tool will achieve 
(known as the strength). You will see these settings at the top. 
 

 
 

Beyond that, the rest is totally up to you to create the object you want from this sculpting 
mode based on your imagination. 
 
Perhaps the only other advice one can give on this section is consider dividing the viewport 
into four parts. One of the four viewports can show the model in its usual standard 3D 
perspective as you had original in the single viewport. The other three viewports should 
show the same model from three specific positions — top, side and front. The advantage of 
doing this is that you can see simultaneously how the sculpting tools affect the model from 
different positions. In this way, you can ensure the model looks right and complete the work 
more quickly. 



Camera Navigation 
 
When you have finished modelling and sculpting your 3D objects, press 0 to see the model 
from the camera view (assuming the camera object is in the viewport — Blender adds one 
automatically when you start up the app just in case you forget to do it). If this key does 
nothing, go to EditàPreferences, and under Input, put a tick on the checkbox that says 
“Emulate Numpad”. Also, make sure there is a camera object in the 3D scene. Look in the 
Outliner panel for a name called “camera”. If it is there, you know you have a camera ready 
to look through. 
 
Why should you look through the camera? It is because when it is time to render the 3D 
scene and all of its 3D object(s) in it, this camera view is what you will see in the final 
rendered output. 
 
Not happy with the camera position? It is time to move the camera. You can do this in at 
least two ways: 
 

1. Find the camera object and move and rotate it like it was any other 3D object (can be 
fun, but not the most accurate). 

2. Press 0 to view through the camera. With the cursor in the viewport, press N. A side 
panel on the right appears. In the View tab within this panel, put a tick in the 
checkbox that says “Lock camera to view”. Now you can navigate the viewport as 
usual and the camera will follow while still allowing you to view through the camera. 
You can rotate, move away or closer to the 3D object(s) (pressing the + or – keys will 
achieve the same effect), or transform to another location, and you can continue to 
see exactly what the camera is seeing. When the camera is in the exact spot where 
you want it, remove the tick in the check box to return to normal without affecting 
the camera object. 

 
Step 2 is by far the simplest and most accurate way of seeing exactly what is through the 
camera. 
 
However, you may wonder why you need a camera at all? Why not just navigate the 
viewport to a position, and tell Blender to render the scene from that position? Makes sense, 
and seems quicker. The only problem is, if you move within the viewport again but want to 
render the scene from that same spot you were before, you will lose this position unless you 
have a marker of some sort to tell you where this position is. That is why you add a camera 
object into the scene. The camera is your marker. Once the camera is positioned correctly 
and pointing in the right direction, it will be saved together with all the other objects, and 
you won’t have to worry about it again. 
 
It is all about never having to remember where you should be to render the scene and so 
make life easier in creating your 3D scene, and rendering it in the end. 
 



Another quick way to move the camera is simply navigate the scene normally until you are 
happy with the view, and press Ctrl Alt 0 to move the active camera and make it point at the 
new view. 
 
Need to have several cameras positioned so you can see the same scene from different 
angles? Not a problem. Glad to see you are developing the director’s eyes needed to 
become a great filmmaker. Blender does it with ease. You merely have to duplicate the 
current available camera object, make it the active camera and move the duplicated camera 
to the new position. Or use the Add menu to add a new camera. 
 
Remember, the quickest way to make a selected camera object the active camera and to 
view what it sees, press Ctrl 0. 
 
SPECIAL TIP 
Speaking of making a camera active, it can be a source of frustration for newcomers to 
Blender how sometimes the camera object is not the active camera for some reason, and 
each time you press 0 it seems you have the camera object in the right position and looking 
at the scene correctly. Yet when you render the scene, the 3D objects do not appear. You 
can be scratching your head (probably the cause for men going bald) looking at lighting, 
materials and render layers as well as the object layers thinking everything is okay but can’t 
figure out why it won’t render. 
 
Here is an important tip to solve this pesky rendering problem. Go into the Scene properties 
panel: 
 

 
 



Look at the name of the object for the Camera. If it isn’t “Camera” (as shown in the above 
picture) or whatever name you have given to your active camera, the renderer will see 
nothing even if you can see through the camera object by pressing 0. Make sure there is 
always an active camera name clearly displayed in the Scene panel and matches the active 
camera you want. 
 
Now you can render the scene.



 
 

Materials and Texture Mode 
 
The time has come to bring out the painter in you. 
 
To create realistic-looking objects like a piece of wood, glass, metal or other materials and 
apply an appropriate texture effect or to simply colour in a 3D object, you must apply (or 
dress up your 3D objects with) a material to the entire or parts of an object and then adjust 
the material’s texture properties such as specular and transparency to achieve the final effect 
you want. 
 

 
 

 
 
A critical thing you should remember is that any new object in 3D space comes without a 
material. Think of a material as like the clothes you wear. When you first create an object in 
3D space, it is actually naked. So we have to give this object some sense of modesty by 
creating a material for the object to be clothed in. Once you have a material defined and 



placed on the 3D object, you can define the texture effect you want the material to display 
when the 3D object is rendered, so it has the desired “realistic” look or special effect you 
want to achieve. Texture means things like specifying whether it should look more glossy 
or matte in appearance, whether it should glow, what colour the material should look, and 
so on. 
 
So how do you create the material, clothe a 4D object with the material, and adjust texture 
effects to this material? 
 
In Blender 2.8, there have been enough changes to require another look at this whole 
process. 
 
 
The simplest way 
 
The first way is to perform a complete clothing of a 3D object using an existing texture map 
file (a graphic image representing a material, such as wood, metal, or whatever). Textures 
can be downloaded online freely from many locations. It is best to know the material you 
want and search online databases based on a category that the material is likely to be found. 
For example, if the material you want is to look like wood, search for “wood”. Download 
the texture to your computer. Keep it in a folder for holding different materials so you can 
re-use it later. 
 
Once you have your material figured out and ready to be put onto your 3D object, the steps 
to clothing the entire object is as follows: 
 



1.! Look at the top menu and search for “Shading”. Click on it. 
 

 
 

2.! Everything is just about ready to clothe the object except we have not added the 
material and linked it up to the object. 

 
3.! Select the 3D object that will receive the material. 

 
4.! In the top left pane, you will see folders on your startup drive. Click only once on 

these folders until you reach the location of your material image file. 
 



5.! Drag and drop this file into the node editor. 
 

 
 

6.! It should look like this after you have dropped the texture into place. 
 

 
 

7.! To actually cloth the 3D object using the material as we see it, put the cursor on the 
yellow dot (or node) that says “Color” on the material, press down the mouse button 
and drag across to create a line and join it to the dot that says “Base Color” in the 
Principled BSDF. 



 

 
 

8. You will notice the object is fully clothed in the material. You can adjust texture 
effects in Principled BDSF, such as Specular (to give the effect of a glossy or matte 
surface). 

 
9. It is good to name this material in Blender so you can re-use it on another 3D object 

without having to search for the material again in the folder. Select the Material 
Properties panel. Where it says “Material”, click on it to highlight it and change the 
name. 



 

 
 



10. If you ever need to re-use the material on another object, select the object, go into 
Shading, click the Material Properties panel, and click this icon to show a pop-up 
menu of available saved materials. 
 

 
 
 
The UV unwrapping method 
 
If you want finer control of where to paint on the 3D object, you must unwrap the mesh 
onto a flat surface. Experts call this UV unwrapping. The big advantage of UV unwrapping 
is not just the finer control of where to paint or add materials, but you can also export this 
information for use in another 3D app, and you can be sure the 3D object will be opened to 
match the original, both in the object’s shape, but also how it looks with the materials 
added. 
 
To apply this process: 
 

1.! Click the LockDev mode button in the top right corner of the viewport. The 
highlighted button is shown below:
 

 
 

2.! Under Shading, put a tick on the checkbox that says “Scene Lights”. This has the 
effect of using all the light objects in your 3D scene for lighting up the objects. 
 

3. Select the object you want to add a material.
 



4. Click the UV Editing at the top. The aim here is to get Blender to automatically 
unwrap this 3D model onto a flat surface. 

 
5. Select the 3D object to unwrap. 

 
6. Press the U key. 

 
7. You can choose “Unwrap” or “Smart UV Project”. The latter is a more intelligent 

approach by Blender to optimize the unwrapping process. 
 

8. Once it is unwrapped, you can begin to paint or 
place an image onto specific faces of the 
unwrapped surface.  

 
9.  Click into Texture Paint. 

 
10.  You will see brushes and a colour wheel. From 

here you can color the faces of the 3D object. 
 
 
Quick materials effects – creating glass 
 
Assuming you have selected faces or an object to have 
the glass effect applied, do the following: 
 

1. Go into the Materials properties panel 
2. Add a new material (if one has not been created 

already). In this example, the material may be 
called Material 001. 

3. In the same panel, set Transmission to 1, and 
enable Screen Space Refraction by putting in a 
tick in the check box. 

4. Now go into the Render properties panel to enable 
Screen Space Refractions and within this setting 
enable “Refraction” with a tick in the appropriate 
box. 

5. If you have additional objects inside the glass 
object that looks a bit blurry, set the roughness 
setting in the Materials to a lower value. 

6. An optional step, and something that might help 
to enhance the glass effect and so make it look 
realistic, you may wish to add a background 
picture. Go into the World properties panel and 
click “Use Nodes”. An icon to the right of Color 
is the option to select a picture under 



“Environment Texture”. 
 



 

Renderer Mode 
 
To see the final results of your modeling and texturizing of objects, you must render the 
scene. Before we do, a number of planets have to align correctly in Blender so to speak in 
order for rendering to work properly and consistently. For example, it is important to check 
things like the camera and lighting is in the scene and pointing in the right direction. But 
this is just the start. There is a ritual that you must perform of checking everything at least 
once in a new Blender file just to make sure rendering works consistently, first time and 
every time. 
 
 
Check the render engine 
 
As obvious as this may sound, the first thing to check before you render anything is to make 
sure you have specified the correct render engine to use when rendering your final scene. 
Obviously, without a render engine, nothing will ever get, well, rendered. But at the same 
time, different render engines can produce slightly different results mainly because they 
each serve a particular purpose. For example, some render engines are more designed to 
speed up rendering in certain areas but loses out on the accuracy and realism you might 
expect. These types of render engines are good as an approximation of how things might 
look. Whereas other render engines are more accurate, but tend to be slower in processing 
the scene. 
 
In Blender 2.8, you have a couple of render engine options. By default, you are given the 
most accurate and highest quality render engine called “Cycles”. In version 2.8, you have a 
new render engine called Eevee. 
 
The only benefit of Eevee is to render the objects and environment more quickly (almost in 
real-time) if you turn off certain render options so as to give you a rough idea of how things 
are likely to look prior to making the final render (when you go back to Cycles). The power 
of Eevee is in selecting certain render options and turning them off (or on) so as to speed up 
the render process for a less accurate but reasonably close result or, if you have the grunt of 
an effective video card attached to your computer, you can bump up the accuracy with little 
or no loss in time during the render process. It is better than the standard grey shaded object 
view, but it is not as accurate as the Cycles render. When you are ready for the final render 
and need everything to be reasonably accurate in the lighting effects on objects, always use 
“Cycles”. 
 
Eevee exists mainly because computers are getting more powerful and faster, and more 3D 
artists find it useful to see the models looking close to the final rendered form to help them 
visualize better and make changes quickly. 
 
The difference between Eevee and Cycles is most evident when it comes to rendering the 
effect of glass on your 3D objects. The essential process required to render glass 



realistically requires complex calculations of how light travelling in a straight line will 
bounce off the surfaces of objects and its intensity after interacting with certain materials 
assigned to the objects. When it comes to glass, additional calculations are required, such as 
the likely frequency of the light and how it disperses and refracts in glass, as well as some 
surface reflections. It is a complex operation done invisibly behind the scenes inside your 
render engine. To get the results to look accurate, you must use “Cycles” as the render 
engine. In Eevee, the glass look will be approximate, and Blender often puts an invisible 
background environment image of its own choosing that is visible only when you look 
through the glass and with basic refraction properties applied. Okay for quick renders, but 
for a background image of your choosing and to see the light interact and bounce around 
accurately with the materials set on various objects and the shapes of the objects, you must 
use “Cycles”. 
 
To change the render engine, go into the Render Properties panel on the right, and where it 
says “Render Engine”, choose “Eevee” or “Cycles”. 
 
If you have a 3D model in the scene, you won’t need to look through the active camera to 
see it rendering with Eevee. You can be in any position you like and the rendering results 
are immediate and surprisingly quick. To start seeing this rendering engine activating and 
turning your model into what you hope it will resemble in the final rendered version but 
with the benefit of reasonable speed, press this button in the top right corner of the 
viewport: 
 

 
 
To improve the accuracy of the render (but will slow the render time), click the Arrow 
Down button on the right (looks more like the letter v). Turn on Surface Lights, Scene 
World, and to speed things up just a tad, Backface Culling. The latter is for 3D objects 
containing a material and applied texture on both sides of the surfaces. It is rare that you 
would need this in most situations (and probably will need see the backside or inside 
surface of objects, so stopping the backfaces from being rendered is actually a good thing to 
do.
 
In the Render properties panel, you are presented with the Eevee option a series of 
checkboxes for features that you can activate to make your 3D object look progressive more 
accurate and closer to the final render. Please note that each feature you turn on will place 
an extra burden on the engine render to create the scene, which in turn will slow down the 
render time and the speed of navigation and sculpting of your object (as well as make your 
computer get hotter as the microprocessor tries to do the high volume number crunching in 
quick time). 
 
Alternatively, you can switch to the Display in Shade 3D view (the default) by pressing this 
button: 



 

 
 
Then you can make your changes, switch to Display in LockDev mode to run the Eevee 
render engine, and don’t do anything else until the render is complete. This approach puts 
less strain on your computer. 
 
Otherwise, if you have enough grunt in your computer, you can turn on the following 
features: 
 

1.! Ambient Occlusion (leave settings to default) 
2.! Bloom (leave settings to default) 
3.! Subsurface Scattering (leave settings to default) 
4.! Screen Space Reflections (leave settings to default)
5.! Motion Blue (leave settings to default) 
6.! Volumetric (leave settings to default). 

 
And for objects that are made of glass but you want to see how light refracts through it, go 
into the Material properties panel. After selecting the glass object, go down to Settings. Put 
a tick next to the box that says “Screen Space Refraction”. 
 
Those are the minimum settings for a particularly good real-time render, so long as your 
computer has the processing power to handle it. 
 
NOTE: Changing the render engine can move and hide certain properties, such as the light 
intensity control when selecting the light object and the Light properties panel. Eevee is a 
new render engine and as such the controls may be more visible and sensible in where they 
are located. The Cycles render engine is an older technology whose settings have not yet 
been updated to be consistent with Eevee. At the same time, some extra options or fewer 
options may appear with a selected render engine, so be prepared for some variations in the 
Properties panels. 
 
 
Check camera 
 
Press the 0 (zero) key. You should be looking through the camera, not just once, but before 
the first time you render the scene. If nothing works, it is probably because you have no 
camera object in the 3D scene. To confirm this, press fn f12 keys. A message may appear 
stating there is no camera. 
 
It is important to have a camera in the scene somewhere. Why? Because whatever the 
camera sees is what will get rendered. Without it means there is no render and, 
consequently nothing will be displayed. It is a good habit of checking this from time-to-



time, especially if you have moved or deleted the camera object, as rendering relies entirely 
on what the camera sees. If the camera can’t see your objects, your rendered scene will 
show you nothing. 
 
Go into Layout or Modelling from the top menu (click on + and choose GeneralàLayout). 
Click the Add menu in the viewport and add a camera object. 
 
Is your camera view still looking a little empty? It is probably because the camera is facing 
in the wrong direction. Go into Object mode and select the camera (best done through the 
Outliner panel). Choose ViewàCameraàSet Active Object as Camera. It is important you 
have an active camera in your scene or nothing will get rendered. Finally, to adjust the 
position and angle of the existing active camera object in the scene, read the section on 
Navigating Camera for the quickest and most accurate way to view exactly what you want 
to see. 
 
NOTE 1: The rectangle shown for the camera object is effectively the camera lens and the 
lines merging to a dot behind it is where the observer would be standing and looking 
through the camera. Imagine a person has a pair of binoculars. He/she is oblivious of the 
existence of 3D objects around the place until you specifically turn the person’s head in the 
right direction. There is no built in artificial intelligence in the camera, as yet, to 
automatically rotate and perhaps position at a right distance when the camera first appears 
in the 3D scene to see the 3D object (or group of objects based on where they tend to 
congregate). You will have to manually direct the camera to exactly where you want it and 
in which direction. 
 
NOTE 2: As you move the camera, you may notice an odd behavior of 3D objects 
disappearing or re-appearing as you move the camera closer or further away from the 
objects.  If you see this, select the camera object. The Camera properties panel will appear. 
In the “Lens” section of the properties panel, look for a setting called “End”. Increase the 
value shown in the field box. In some cases, you may have to put in a significant value to 
properly show all the 3D objects. 
 
 
Check lighting 
 
You must add a lighting source if you have not done so, and move it to the right location to 
shine light on your 3D object. Otherwise, your objects and the environment will be rendered 
black. As the old  Biblical saying in Genesis 1:3 goes: 
 
God said, “Let there be light,” and there was light. 
 
and suddenly out of the darkness came the visible universe. Well, the universe is just like 
your 3D environment. You are the creator of your 3D universe and you must add light to it 
in order to see what is going on in the 3D universe. There must be at least one light source 



somewhere in your scene (usually in front of the 3D object either in between or behind the 
camera. 
 
With practice and experience, you will learn the best lighting of a 3D object while 
minimizing shadows is to use three light sources — one in front, and two to the side, of the 
3D object to light up everything. 
 
Use the Add menu in the viewport to add a light source object. Make sure you are in Object 
mode when you do this. Press G for grab to move the lighting source object to where you 
want it. You want the light to hit the surface and get reflected or emitted in the direction of 
the camera. Imagine rays of straight lines representing the light hitting the object. When 
they get reflected like a mirror, where will the lines go? If the lines can reach the camera, 
you will see the object. 
 
The most popular choice of a lighting source has to be the “Sun”. Use it to send light in all 
directions to help light up as many surfaces as possible. If you need to light up a specific 
spot on a 3D object, use a spot light instead. 

 
To change the lighting source, select the lighting 
object you want to change, go into lighting panel 
and choose from a pop-up menu a different 
lighting source for the object. 
 
NOTE: In the Cycles render, the control for light 
intensity is hidden. Select the light object, go 
into the Light properties panel, click “Use 
Nodes” and the intensity setting will appear. Th e 
setting is more upfront and clearer under Eevee. 
 
 
Check size and resolution of the final 
rendered scene 
 
The final thing to check is in Dimensions under 
the Output properties panel. From here you can 
specify the resolution of the rendered scene (in 
terms of number of pixels for both width and 
length). 
 
NOTE: Blender does not show a numerical 
number representing the resolution in dots per 
inch (dpi). You have to convert the image size 
generated by Blender to the required dpi 
resolution (e.g. 300dpi) using a separate image 
editor (e.g., Adobe Photoshop or another graphic 



editing app). When you do this, turn off the option in the image editor to resample the 
image to the new image size. 
 
Also specify whether you want PNG, TIFF, JPG or other graphic file format for the 
rendered scene image when it is saved, the location of the image file where it should be 
saved, and specify if the image should be black and white (BW) or colour (RGB or RGBA) 
and the colour depth (8- or 16-bits). 
 
As for other settings, there is little need to modify them unless you are ready to render an 
animation sequence. As for Aspect Ratio, the Blender manual states that “Older televisions 
may have non-square pixels, so this can be used to control the shape of the pixels along the 
respective axis”. As modern TVs and computer displays do not have it, you can safely leave 
Aspect Ratio to X=1 and Y=1. 
 
Apart from the graphic file format and color depth, your only control is resolution in terms 
of width and height. For advice here, you should consider where the final rendered image 
will be displayed. Is it for a smartphone, or a large cinema screen? Or is it for standard High 
Definition (HD) TV? 
 
You also need to think about whether you intend to use After Effects or Premiere Pro or 
some other video app to animate the Scale function in order to move into a rendered scene. 
If so, it is recommended that you set a higher resolution width and height. For example, if 
the final rendered image is going to be shown only on the standard High Definition (HD) of 
most modern television sets, which will have a dimension of 1920 (w) x 1080 (h), you 
should set this to a higher pixel dimension. Try something like 4K Ultra High Definition 
(UHD) of 3840 (w) × 2160 (h) pixels, or to be really safe, try 8K UHD of 7680 (w) × 4320 
(w) pixels. 
 
 
Render the scene 
 
Finally, with everything checked (yay!), you can press the fn button followed by F12 to 
render (Note: Expose of OSX could be assigned this function key, so remove it in the 
Expose and Spaces system preference pane). Or go into the Render menu and select 
“Render Image”. 
 



 
 
In older Blender versions, you also had a Render button. For Windows users wanting to re-
introduce this button solution to Blender 2.8, visit this web page: 

https://github.com/Mitsuma/Blender2.8-RenderButton 
 
 
To get out of the rendered scene 
 
To get out of the rendered image, move the cursor inside the viewport and press Esc button. 
If you are in the middle of rendering the scene, press Esc once to stop the render, and again 
to return to the Layout. 
 
Alternatively, in the menu at the top, choose +!General!Layout, or 
+!General!Modelling to get back to the 3D environment. Or press fn f11 keys to switch 
between your 3D edit scene and renderer. 
 
NOTE: If you save your Blender file in this Render mode and re-open in some far distant 
future when you barely have much recollection of what you did in the file and start to 
wonder why you can’t see your 3D model ready for editing, it is because you are still in 
Render mode. The rendered image may disappear just to make it worse for you and make 
you think the 3D object has been lost. So press fn f11 keys to get back to the editing mode 
and save again. 
 
 
Output the rendered scene to a file 
 
Again, as there is no obvious button in the Render or Output Properties panel to save the 
rendered scene, pressing fn key followed by F3 for Blender versions prior to 2.8 would 



have been okay. However, in Blender 2.8, the standard key combination does not work. 
Instead you must render the scene and click the Image menu command, followed by choose 
“Save As…”. 
 

 
 
 
Problems with rendering in different Blender versions 
 
Generally there should be consistency in the final render in most situations and for different 
Blender versions. However, with Blender 2.8, there have been enough changes that could 
cause the same render engine to show some differences in appearance of 3D objects. For 
example, you may find some 3D trees with leaves have suddenly lost enough leaves to 
make you think the trees are dying of thirst and dropping at a great rate when you render in 
Blender 2.8 beta, compared to the same file rendered in Blender 2.79. If you see this, you 
know Blender 2.8 has had substantial changes done to it. Also, don’t use Blender 2.8 beta 
and this is the likely cause of this problem. 
  
Just to be safe, always make a copy of a 2.79 Blender file and render that file in Blender 2.8 
or higher. If you cannot see any differences in the final rendered look, you are probably fine 
to move over to the latest Blender version. However, if there are differences, try a different 
render engine, re-import/append the affected 3D objects, check that the normals (i.e., the 
direction that light will get reflected off the surface) are facing for each of the faces on the 
3D objects the right way (if they are not, the faces will be invisible), or go back to the older 
Blender version. 

Also, keep in mind that the Blender version you decide to open a file with may not be 
compatible with an older version. If you have received a file created on Blender 2.79 from 
another person, this can be opened in Blender 2.8. However, if you decide to make changes 
and save the file and give a copy of it to the other person, he/she may not be able to open 
the file in Blender 2.79. This is because enough changes have been made to the file by 
Blender 2.8 to make it impossible to open in Blender 2.79, except to Append objects from 
the file (that is your last resort if all else fail). 
 



If you are working with anyone using Blender 2.79 or older, make sure you establish the 
groundworks of which version of Blender to use. And do some tests to see whether the 
results will vary with different Blender versions. If you find they look the same, there 
should be no problems other than not being able to open a newer file in Blender 2.79 once it 
has been saved in the 2.8 format. So get agreement on the right Blender version to use and 
stick to it.  



Compositing 
Doing more with the renderer 

 
This is a little understood feature for newcomers, but considered one of the most useful and 
powerful tools you have in Blender. It is designed to help you apply special effects (not 
unlike the filters you apply to a graphic image in Adobe Photoshop) to rendered 3D objects 
of your choice. In that way, when the time comes to render the 3D scene, those objects that 
need the special effects are rendered separately and special effects applied, and later they 
are added or mixed with other rendered objects to create the final composite rendered 
picture. 
 
It is useful for things like trying to create a blur effect on a rendered 3D object that is meant 
to be moving or would appear naturally blurred as in a lightning bolt, but, of course, it could 
be any other effect you wish to apply to any 3D object. 
 
To understand this feature, you must first decide which 3D object is going to need a special 
effect applied. Once you have worked this out, you need to separate the 3D object from the 
rest of the scene, since you are not going to apply the special effects to all the 3D objects. 
Here are the steps to achieving this: 
 

1. In Object or Edit mode, use the selection tools to select the 3D object. 
2. In Object mode and with the cursor in the viewport, press M. A window will appear 

and you will see buttons arranged in a grid-like fashion. If you have some familiarity 
with Blender 3D, you will recognise these buttons as the layers buttons. In fact, that 
is exactly what they are. 

3. Click a different layer button to the one where the object is currently located. This 
will move the object to a new layer. 

4. Click the Render button.  
5. By default, all rendering is done once on all the 3D objects. A default name is give to 

this render called “RenderLayer” Thus when the name is highlighted by clicking on 
it, you will see below the same layer buttons, but this time all the layer buttons have 
been turned on. This means all the 3D objects stored in their own layers are brought 
across to the Render engine and rendered once to create the scene. However, we need 
to tell the Render engine to break the rendering into individual renders in order to 
apply the effects we want on a specific layers. 

6. Rename “RenderLayer” to “Scene” or other name to represent the 3D object you 
have stored in Layer 1. Click Layer 1 button in the render panel to make sure only 
Layer 1 is rendered normally. 

7. Click the + button to create a new Render layer. Name the layer something else. Let’s 
call it “Object Effect”. Click Layer 2 button in the render panel to tell it the rendering 
to the 3D object in Layer 2 will be performed separately from the other render layer. 

8. Turn off Sky option for all the render layers. 
9. Turn off Mask Layers buttons. 



10. Now re-render the image by pressing fn key followed by F12. You need to do this 
before we enter the compositor. 

11. To see the Compositor, press Ctrl Left Arrow, or choose Node Editor from the Editor 
Type menu (next to the View menu). To get out of the Compositor at any time, press 
Ctrl Right Arrow. 

12. Make sure in the Compositor window that the check box called “Use Nodes” has a 
tick in it. You should see two boxes called “Nodes” and a link between them between 
two yellow dots. If you don’t, you will get an error message during rendering stating 
“No render output node in scene”. If you ever see this message, the following two 
default nodes need to be added (a) Render Layers; and (b) Composite. You add these 
nodes in the Add menu (next to the Node menu). Hence Add->>Input-->Render 
Layers and Add-->Output-->Composite. Drag and drop the input yellow dot marked 
“Image” in one node to “Image” in the output node. That’s it. When you render the 
3D scene normally, the information will pass through these nodes and get processed 
to produce the final rendered output scene. 

13. However, you will need additional nodes in between the input and output nodes. 
These additional nodes tell how to apply special effects. So, for now, you need to 
break the link between the nodes and start creating new links starting from the input 
node (the output Composite node is not needed and can be deleted). 

14. The input node you have is likely to be focusing on rendering just one render layer Of 
course, you are going to need to grab all the render layers, apply special filters on one 
or two of these layers, and combine these layers with other layers to form the final 
composite rendered picture. So add new Render Layer input nodes to the Compositor 
window and change the render layer to focus on from the pop-up menu. 

15. If you want to see the rendered images of each of these input nodes, you can add an 
Output node called a Viewer. Once linked to the input node, you will see the output 
rendered image as a backdrop in the Compositor window by putting a tick in the 
backdrop check box. 

16. For the purposes of creating a special effect, you will not need the output viewer node 
at this stage. Remove the output viewer node from the Render Layer input node 
where you are going to apply a special filter. 

17. To apply a special effect to a rendered image for one Render Layer, go into the Add 
menu and choose a filter or some other function you wish to apply to the rendered 
image. For the sake of an example in this case, let’s choose Add-->Filter-->Blur. The 
Blur filter node appears. Create a link between the two yellow dots. 

18. To see the effect of this filter to the output rendered image, add an Output Viewer 
node and link it to the Blur Filter node. With the backdrop option turned on, you 
should see what will happen. 

19. Use Add-->Color-->Mix to add a Mix Node and an extra Output Viewer node so you 
can click into it (always remember to click into a Viewer node in order to view the 
output) and see the rendered result. Create links where appropriate to get the result 
you want. Here is a typical link and node structure 
 



 
 

20. Simplify the nodes and you could have something like this; 
 

 
 

21. Everything looks fine in the backdrop rendered image? No worries. Now add the 
Output Composite node and drag the expected output to the composite node. When 
you do this, you can click the fn key followed by F12 (or click Image button in the 
Render panel) to render the 3D scene including applying the filters to get the final 
rendered result. 

 
 
 
 
 



Problems rendering certain 3D objects? 
 
If you have any rendering issues for certain 3D objects not appearing in the rendered scene 
after adding a few new nodes and relinking everything (and rechecking the node links), put 
a tick in the check box that says “AutoRender”. And, if texture, lighting, camera position 
and ensuring the camera is active are okay and pointing in the right direction, and the render 
layers are properly defined and included as RenderLayer nodes in the compositor, open up 
the RenderLayer node corresponding to the problematic 3D object and click the camera 
icon button to force a render. 
 
Alternatively, create a new RenderLayer node and select the render layer containing the 3D 
object and redirect the Output Composite node link to this new render layer node. Use this 
method to eliminate other nodes as somehow contributing to the rendering problem. 



Exporting 3D Models 
 
As Blender 2.8 still does not come with a plug-in for direct use of Blender files in Adobe 
After Effects or some other video compositing app, you must export the model or animation 
into a suitable file format. Fortunately, being an open source app, the options for exporting 
are more forgiving and flexible than Cinema 4D Lite. Otherwise you may be required to 
pay a lot for a decent 3D app. 
 
In terms of the preferred file format, Wavefront’s OBJ file format is arguably the most 
common and readable on virtually any application that can handle 3D environments. The 
other popular file format is FBX. However, to save time re-texturizing components of a 3D 
model in another app, you have to export the model the right way within Blender by 
clicking on appropriate settings. And you also have to make sure the “normals” of each 
individual face representing the 3D object is facing outwards (i.e., you can see the surface 
and its textures). 
 
 
Setting the normal in the right direction 
 
In most cases, you would never have to worry about this. Many 3D objects you create or 
may receive as a file from other people, especially those that are freeware, will appear okay. 
However, there are a few that may contain some faces that are not facing in the right 
direction. When this happens, a transparent surface will appear in certain parts of the 3D 
model when it is rendered. You will not see this in Blender. It is only after you have 
exported the model and use in another 3D app (such as Element 3D), will you notice the 
anomaly. To fix this, we have to flip the “normals” as it is called for those faces facing the 
wrong direction (usually inwards of the 3D model). 
 
To fix the problem: 
 

1. Select the mesh object you suspect is showing transparent regions on parts or all of it. 
 

2. Go into Edit mode. 
 

3. Go into Viewport overlay. 
 



 



 
4. In the Normals section, press this button: 

 

 
 

5. A series of tiny lines appear on the faces of the model. If you don’t see any lines, all 
the faces are facing the wrong way. Lines coming out of the faces tell you they are 
facing the right way. 
 

6. If the entire mesh is flipped the wrong way, choose MeshàNormalsàFlip Normals. 
If there is a mixture of normal when opposite directions, choose 
MeshàNormalsàRecalculate normal to get them all facing a consistent direction. 
Then decide if the faces need to be flipped again. 

 
 
Exporting 
 
The two essential methods of exporting textures with a 3D model are: 
 

1. Creating a UV mapping and exporting the model as OBJ or FBX. 
 

2. Exporting texture files for each component making up the 3D model (will appear as 
PNG or JPG files) together with the 3D model as OBJ or FBX. 

 
UV mapping is the most common and reliable way to ensure a 3D model looks right in 
another application. UV maps also provides all the complexities of painting and applying 
textures while ensuring the results look the same in another application (other than applying 
some additional effects unique to the 3D app). If you hope to have the 3D model look the 
same in another app and have the textures automatically applied to the 3D model the right 
way every time, or you want to do some custom painting over specific positions on the 3D 
model in Adobe Photoshop or some other graphic editing program before re-wrapping it 
back to the 3D model by a 3D app, you must perform a technique known as UV 
unwrapping. Otherwise, you must have separate PNG or JPG texture files and you must 
“colour in” the components of the 3D model in another application using these texture files 
in a more manual way. Or hopefully the 3D app is smart enough to know how to apply the 
textures with the help of another file called a materials reference file (usually having the 
MTL file extension). 
 
Which would you prefer? 
 
The second step is to export the geometric mesh data (i.e., the 3D model itself) because this 
is how you tell another 3D application the shape of the 3D model and all its components. 



 
 
Create UV mapping 
 
The steps required to UV unwrap a 3D model are as follows: 
 

1. Change to Edit Mode if you are not already in this mode. 
 

2. Select the 3D model or parts of it for unwrapping, or press A to select all objects 
(remember, the cursor must be in the viewport for this to work). 

 
3. With the cursor in the viewport, press U. From the pop-up menu, the most common 

selections you will be using throughout your life using Blender is Unwrap, Smart UV 
Project, and Project From View: 
 
(a) The easiest UV unwrapping option for beginners is “Project From View”. This 
will look at the model from the position you are viewing it, and whatever vertices 
have been selected will be laid down flat for you to paint on top of it, or shows the 
textures. 
 
(b) The computer chooses the optimum way to unwrap based on your selected 
vertices. 
 
(c) The Unwrap option is most commonly used in the industry to give greater control 
to the 3D designer. It is particular useful for character texturing, but any object can 
benefit from this option. The option is best used in conjunction with defining seams 
where the unwrapping can break and allows for different surfaces to have separate 
unwrapped regions all nicely laid out on a flat surface. 
 

4. If you don’t define seams to make it easier for Blender to UV map your 3D model, 
you can choose “Unwrap”. Blender will make an attempt to lay down the UV map in 
the best way it knows. 
 

5. In the menu commands right at the top, you will see UV Editing. Click it. 
 

6. The unwrapped surfaces should appear in the left window pane. The 3D scene will 
appear in the right window pane. 

 
7. To confirm this fact, you should be able to select vertices, edges and faces in the left 

window pane. Also, any textures should appear on the unwrapped flat surface. 
 

8. With greater experience, you can tell Blender where you want to put seams (places 
where Blender will cut with an electronic scissor and lay it flat down). You can add 
seams and repeat the unwrap option to see how easier it is to see all the textures (and 
makes it easier later to custom paint it). 



 
NOTE: The menu command to unwrap a 3D model will only work if you have a 3D model 
selected (i.e., highlighted in orange). 
 
 
 
Export to OBJ 
 
To export a selected 3D object: 
 

1. Choose FileàExportàWavefront (.obj). 
2. In the export settings (lower left corner), put a tick in the box that says “Selection 

Only” if you have selected a 3D model to export, or leave it blank to export 
everything. Put a tick in “Apply Modifiers”, “Include Edges”, “Write Normals”, 
“Include UVs” (this is crucial if you have unwrapped the 3D model), and “Write 
materials”. In Path Mode, select “Copy”. All other boxes should have no ticks in 
them. 

3. If you have correctly unwrapped your 3D object, you should see an obj file 
containing your mesh information, an mtl file containing the material definition, and 
all texture files referenced in the mtl file. 

 
Once you have this information, you can import the files into Elements 3D (a third-party 
After Effects plug-in), all textured and ready to go within Adobe After Effects. Or you 
can import in another 3D application (if, for any reason, you cannot do everything in 
Blender). 
 
Technically, it is at this point that there should not be anything more to do with the 
models except add shading, lighting, and camera in After Effects and animate the 
models to make them look realistic and seamlessly merge with the After Effects scene. 
 
It is as simple as that. 
 
 

Importing 3D Models 
 

Importing in Blender 2.8 is reasonably flexible and sufficiently accurate to be considered 
a reliable feature. Furthermore, being an open source package, you have a variety of file 
formats to import from. The only exception is Cinema 4D, which is a proprietary format 
(designed to force users to stay with Cinema 4D once they have created enough files on 
it). 
 
To import a 3D model created in another 3D package, look under FileàImport. In some 
cases, you may have to go to the original 3D application and export it into a file format 
that Blender can read. 
 



The process is fairly straightforward, assuming the original 3D models have been 
exported correctly. The only important observation worth keeping in mind with Blender 
is that usually the model will get imported either too small or too large for you to see 
what has happened. If you have imported a 3D model without a problem and can’t see 
anything in the viewport, we recommend that you use the zoom tool to navigate the 
viewport further away or closer in to the grid’s origin point and hopefully you will see 
the object appear. Or consider selecting all objects and use the Scale tool to adjust the 
size. 
 
Another option is to use the Layers properties and select the components of the 3D 
model. This should highlight the 3D model (wherever it is). Then try the Scale tool to 
blow them up until the model is visible. 
 
However, another “pain in the you know where” scenario is when a 3D package exports 
a model with additional information than is unwarranted or often ends up making it 
harder for another application to apply the Scale tool. Bad enough if the object is too 
large or too small. For example, if you find the Scale tool causes the 3D model to move 
away from its original position, it is likely the pivot point for the object is placed well 
away from the 3D object itself. Until the pivot point is placed at the body’s volume 
center, any scaling will push the object well away from its original position, often in a 
dramatic fashion. 
 
In this latter situation, you have several options to fix the issue, but the easiest is as 
follows: 
 
1. Click the Cursor tool (in the Tools palette towards the top left region) 

 

 
 

2. Click in the viewport somewhere on the grid where you want the cursor icon to 
appear. This will become your new pivot point for any 3D object you will highlight. 
 

3. Highlight the 3D object by any reasonable means. The aim is to move this object to 
the pivot point. If you can’t see the object or do not know where it is, then select the 
components making up the 3D model from the Layers properties in top right corner. 
Hopefully the components are named clearly to let you know what they are. Where 
you see “Camera” and “Light”, ignore those objects. Better still, any objects not 
related to the 3D model you are going to move should be made invisible by clicking 
the “Eye” icon next to them. This should ensure those unnecessary objects do not 
interfere with Step 4. 
 

4. In Object Mode, go under the Object menu in the viewport and choose 
SnapàSelection to Cursor (Keep Offset). 3D model will move to the pivot point. 



Once you do this, you can scale up the model until you see the object clearly without 
making it move away from this point. 

 
This is a major problem with 3D packages. Many commercial packages do not like to 
play nicely or apply some standardized settings during export so that another 3D 
package can read it. Hard enough to get everyone to agree on a standardised file format, 
even if there is only one simple 3D object in the scene and deciding where it should be 
placed and at what scale. No wonder these players prefer users to use their product only 
just to save on all the hassles. Where profit is involved, expect difficulties transferring 
3D objects from one app to another. However, for open source 3D apps such as Blender, 
this is different. Exporting 3D models and re-importing them is more consistent and 
predictable. 

 
SPECIAL TIP FOR C4D USERS 
In Cinema 4D (C4D), you can copy a selected object you can’t see, create a new window 
and paste, and miraculously the model will appear in the origin and just large enough for 
you to see it. However, the object’s pivot point will unlikely be at the body’s center of 
mass. You must move this origin within C4D, or export it to another 3D app to make the 
adjustment there. 
 
 



Animation 
 
This final section covers the essentials you need to know in order to animate your 3D 
scene within Blender 2.8. 
 
Now that you are comfortable with adding objects and moving them around in 3D space 
as well as manipulating the objects, there is an option to animate 3D objects, including 
the camera and light objects, over a specified time frame, and export the rendered scenes 
sequentially as a video. 
 
If you would like to get into animation, you should keep in mind the following: 
 
1. The more complex the 3D scene containing multiple 3D objects, the longer it takes to 

render a single frame. As animation requires multiple frames to be combined into a 
video for playback at a speed that gives the impression to the human eye of motion, 
rendering an animation can take time depending on the power of your computer. We 
cannot stress enough the importance of getting a decent and fast computer for this 
kind of work. A typical 1 second motion video to fool the eye into thinking it is a 
smooth movement requires around 24 frames (or individual rendered pictures) per 
second. So you have to render 24 individual images of the 3D scene (with slight 
changes to the 3D objects with each frame) and with reasonable accuracy to look 
realistic. If your machine is slow, this could potentially take hours. For a three 
minutes video, rendering time could take days, weeks or months. If you intend to do a 
lot of animation in Blender, we highly recommend that you purchase the fastest 
graphics card that you can afford and is compatible with your machine. When you do, 
the time to render everything will be cut back dramatically. The graphics card also 
has the advantage of freeing up the main CPU on the motherboard to do other work 
while letting the graphic card perform independently the number crunching required 
to create your final rendered scenes. 
 

2. Make sure you get the scene and all the 3D objects looking right first before 
attempting to render the animation. If you make a tiny mistake, you probably have to 
re-render the animation. 

 

How to animate 
 

Below the viewport is a window pane devoted to animation. 
 

 



 
The numbers across the bottom represent the frame number. To specify how many 
frames are required in your animation video, consider the 24 frames per second standard 
as we mentioned earlier. So, if you want, say, one minute of animation, you will require 
24 frames per second x 60 seconds = 1440 frames. Once you know how many frames 
are required, type the total number of frames in the top right corner of the animation 
window pane. 
 

 
 
You can also set the frame start and end by clicking the Output properties panel, which 
incidentally is the place to change the number of frames per second if you are inclined to 
vary this from the standard 24 frames per second value. 
 

 
 
If you would rather see seconds rather than frame numbers, look for the View menu and 
choose “Show Seconds”, 



 
The essential technique to animate a 3D object is to first position, rotate and/or do any 
other manipulations as well as specify the initial property state of the 3D object. By 
state, we mean any material properties you want set for the object. For example, a 
glowing effect is one state. A different state might be without a glow, or a more intense 
glowing effect. 
 
Once the object is in the right spot and/or state and looking the way you want (and has 
been selected), you need to specify which frame number you want this information about 
the 3D object to be recorded. In the timeline, You will see a thin blue line to the left. 
This is your marker to select the frame number you want. 
 

 
 
To move this frame marker, PC users only have to press on the marker by right clicking 
on the mouse button and dragging it across. For Mac users on a laptop, this is not so 
obvious and can be a source of frustration for newbies not familiar with the PC origins 
of this 3D app and the way the Animation is set up. If you find you cannot move the 
marker by any means: 
 
1. Go into Preferences under the Edit menu. 
2. Choose Keymap 
3. Look for PreferencesàSelect With. 
4. Click the button that says “Left” to activate it. It will turn blue. 
5. You are ready to left click the mouse button to select things. 
 
For trackpads, get two fingers to touch the trackpad while the cursor is in the timeline. 
Press down to click the cursor in this timeline. The blue keyframe marker will move to 
the cursor position. Keep the trackpad button pressed down and move the fingers to 
move the marker. Let go of the trackpad when you have marked the right keyframe 
number. 
 
Once the blue line frame marker is on the right frame number (perhaps frame number 1 
is fine), you can press I for Insert. The menu only shows when the cursor is in the 
viewport. 
 
NOTE: Sometimes you may see the word “Key” just above the animation timeline. If 
you see it, this will show the same pop-up of menu commands. 



 
Now if you have decided that the only thing to animate is the position of a 3D object, 
choose in the pup-up menu the “Location” command. 
 

 
 
A series of three yellow dots lining up vertically will appear on top of the blue line 
marker. This tells you that the X, Y, and Z coordinates were recorded. If you do not see 
the yellow dots, don’t panic. You are doing it right. The dots are probably hidden. With 
the cursor inside the Animation timeline, drag the timeline all the way down until you 
see the dots (they are hiding at the top). The number of dots shown represents the 
number of data points to be records. For position, three dots will appear to represent data 
for each of the coordinates. The data can be modified manually in the timeline for fine 
control. 
 
Move the keyframe marker to another keyframe number. Move the selected 3D object to 
another position. Press I for Insert and choose “Location” again. Another three yellow 
dots will appear telling you it has recorded information about the new location into this 
keyframe number. 
 
Now, if you move the blue line frame marker between these yellow dots, you will see 
the 3D object is moved automatically for you. 
 
Congratulations! You have created an animation. 
 
 



Export 
 
We will leave the rest of the option in the Insert pop-up menu to your creativity, but the 
final step is to render the animation and save the sequences of images as a video under a 
certain file format. 
 
Go into the Output properties panel. Select the movie file format (we recommend 
“ffmpeg video”). Encoding will appear in the Output properties panel. Click the tiny 
triangle to open Encoding and under “Container”, choose either H.264, MPEG-1, 
MPEG2, MPEG4, QuickTime, or AVI. The last option is mainly useful for Windows 
users. QuickTime is mainly for Mac users. For greater chances of the video being 
viewed under a wider range of platforms, try H.264 or MPEG (you choose the number, 
but generally the higher the number, the more modern the file format architecture is, 
which means that video files may have better file compression for a more compact file 
without losing on the quality of the video images, or the quality of the picture is better 
for the same level of file compression). If you must choose between H.264 and MPEG-
4, go for H.264 for the best quality at a reasonable file compression level (and currently 
is the world standard). Both video codec file format options do provide settings to vary 
the file compression and hence the quality (which may be necessary for internet use), 
You can also control the sound codec type to save with the video file. It is tempting to 
go for MP3, but some people have found that it may work on some machines but not on 
others (mainly because not all machines have the MP3 decoder installed to correctly 
decode and play the sounds). For greater compatibility of the sound on more system 
platforms including the internet and a greater sense of reliability without loss of quality, 
choose AAC. Again, there is the option to control file compression via the “Bitrate” rate. 
At 196bps for the bitrate rate, this is good quality for most things. At 320 bps, the sound 
improves and has a greater dynamic range of sound frequencies to give you the quality 
you want. 
 
In the Output properties panel and under the Output section, specify where you want the 
file to be saved. 
 
Finally, put a tick in the check box that says “File Extensions”. That basically tells 
Blender to put a three or four letter extension to the end of the filename to help some 
operating systems and apps figure out the file format of the video and play it using the 
right decoding tools. 
 
Now you are ready to render and save the video. 
 
Look for the Render menu at the top of the Blender window. Click on it and select 
“Render Animation”. Let it render the scenes until it is finished. You can save the results 
(or more likely Blender will automatically save the video for you as a means of saving 
space in RAM for the purposes of rendering your scenes). 
 
 



Video Editing 
 
Blender 2.8 also has the power to import multiple videos and apply various video editing 
tools to create the final video. To enable these tools, go under FileàNewàVideo 
Editing. A window pane dedicated to video editing and a new viewport window is 
shown. Use the Add menu to add a clip/video. 
 
Importing a video shows both the audio and visual components of the video in a 
timeline. Each can be manipulated, such as cutting sections of the audio or video aspects 
and moving them around. Shift K would be the keyboard command to cut once you have 
marked on the video clip where to put the cut. 
 
Once you have imported various clips and done your manipulations, you are ready to 
export and save the final video from Blender. 
 
One word of caution, video editing can be a processor intensive activity. Like the 
animation section, it is strongly recommended that you have a powerful enough 
computer to make the video editing process seem pleasant and quick. 
 
That’s it! 
 
You now know the essentials of using Blender 2.8. 



Which 3D package should I learn? 
 
Blender is not the only 3D modelling package out there. You can choose from Cinema 4D, 
Maya, 3DS Max, Houdini or Pixologic ZBrush (the more established players in the 3D 
software market). There are other lesser known ones, such as Rhino 3D, Cheetah3D, AC3D, 
3Delight, AutoQ3D Community, SketchUp, and Moment of Inspiration by Triple Squid 
Software Design, that have a much lower price tag, but are powerful in their own right. 
However, in terms of a free 3D app bristling with features, Blender 2.8 is currently the best, 
and is certainly better than the free Art of Illusion, K3D, Sculpturis and Seamless3d. To 
discover the full range of 3D apps in existence, visit 
https://getalternative.net/software/element-3d. 
 
Of all these apps, Maya has been around the longest and is considered the industry standard. 
It can do almost anything you want to a level of realism that will blow your mind away. In 
recent times, Maya has focused on the sculpting and free flowing side of editing 3D objects, 
and introduced features such as realistic 3D hair on animals and human heads and make 
them move for animation purposes (see James Cameron’s Avatar). The app is definitely the 
best there is on the market, but it does have a steep learning curve (and very expensive to 
buy) in order to master all of its intricacies. 
 
Houdini is a recent entrant in the 3D market. Like Maya, it has a focus on the free flowing 
side of 3D modelling, and has a steep learning curve because it is more data driven to create 
the amazing effects in 3D, sometimes even better than Maya. 
 
3DS Max is owned by the same company as Maya (this was acquired some years back). 
However, instead of merging the two products, a decision was made to push 3DS Max to 
become more dedicated to architectural and engineering requirements. It has its own set of 
efficient and powerful tools to make the task of designing a vast building complex, a car, or 
something else look effortless and realistic. 
 
Cinema 4D is a bit unusual in the sense that it doesn’t try to be specialized in one area or 
another as does 3DS Max and Maya. It is able to do everything very well. It has a powerful 
and fast rendering engine that allows the app to achieve the same quality as Maya or 3DS 
Max. The one thing that most users find Cinema 4D particularly pleasing is its more 
intuitive user interface. The amount of learning required to master this package is much less 
than Maya. 
 
There are other 3D apps, but not all are designed to create a 3D object from scratch. Many 
of them assume you have the 3D object already made in SketchUp, Cinema 4D, Maya or 
some other app. In which case, all you need is to import the object(s) and set up the scene, 
and render the lot. Then you can create a video from the animation sequence or render as a 
single frame. 
 
The best of these 3D “presentation” apps is Lumion. This app focusses on design of the 
scene to complement a ready-made 3D object(s). The scene can be prepared very quickly, 



and renders are almost in real-time using a good quality graphics card. However, the biggest 
advantage of Lumion is its level of photorealism and accuracy in the way light interacts 
with the object and the entire scene. It is perhaps the most accurate and photographic 
looking 3D render you will ever find, and you will pay dearly for this precision and quality. 
 
Lumion is a bit like Element 3D (or the alternative ProAnimator 8 plug-in from 
https://zaxwerks.com/proanimator) in that you can select parts of the object and change 
textures. You import 3D objects made in another application (usually an architectural 
building created with 3DS Max or another 3D modelling package), and Lumion will allow 
you to quickly set up and modify the scene. Hence the ability of Lumion to create excellent 
3D landscapes is not to be underestimated. It will let you choose a default 3D landscape and 
modify it to get the result you want. Add clouds and change the type of clouds and how 
many of them you want, add mountains in the background, select parts of the landscape and 
dig holes to create a swimming pool, river or lake and add water, as well as position the 
sun. 
 
And to save time, Lumion has an extensive 3D library of ready-made objects in case you 
forget to add extra things into your 3D scene, such as a car inside the garage of your newly 
created 3D house. 
 
Lumion is more geared up for the designer who wants to use completed 3D models, and 
have them displayed in a scene, render the lot quickly, and create the video or still frame 
knowing it will have the tremendous accuracy and realism. In fact, people who look at a 
finished Lumion scene have trouble determining whether the result is a photograph of a real 
landscape. 
 
However, in terms of a proper 3D modelling app to create the objects, Lumion needs to be 
complemented with another 3D app. 
 
So choosing any other commercial version of a 3D modelling app will meet your 
requirements. 
 
But since Blender came on the scene and still remains a free app, some commercial makers 
of 3D apps are keeping a close eye on its development. 
 
Maxon, in particular, has had to find ways to entice users to try Cinema 4D and stick to this 
package rather than Blender. This is where Adobe’s After Effects comes into the picture. 
With a dedicated After Effects plug-in that integrates Cinema 4D and offering a free 
Cinema 4D Lite app (which can only be run if After Effects is running), Maxon has found 
an edge over Blender. 
 
Other companies are different. The makers of Maya and 3DS Max have little to worry about 
as there are enough people using the apps. People know these apps come with amazing 
features. Knowing the features are there and ready to use, it is usually enough for people to 
settle on one of these apps and forget the rest. 



 
This bring us to which package you should use. Is there a best app. Well yes, the best is 
Maya, except the price tag and steep learning curve may not be the best features of the 
product. 
 
If you do not want to buy the top-of-the-range Maya app, there are a number of factors you 
need to consider before acquiring a 3D package. The first is whether you want to create 3D 
models from scratch as well as the entire scene in one 3D app. Or whether you will pay 
someone else to create the models and you import them into a designing app such as 
Lumion to “present” the results and add a scene for that added level of realism and knowing 
the end result will be virtually photographic quality. If you do not intend to create lots of 3D 
models for yourself or make a living creating 3D models for others, you might be better off 
commissioning someone to create the models to your specifications. Then, with the 
completed models in a suitable file format, such as FBX, you can render the result and add 
a scene using Lumion. Or, if it is just one or a few 3D objects, Element 3D plug-in and 
Adobe After Effects may be all you need. 
 
In terms of actually choosing the right 3D modelling app, you have to know if you must 
work with other experts building 3D objects. If you are going to work with others, you have 
to know what the industry experts are using. If the experts are already using Maya and you 
must work in a team of other 3D experts in a seamless way, you may be required to learn 
Maya. 
 
On the other hand, if it is for personal use or within a business and you do not intend to 
create Hollywood blockbuster movies but only some carefully-crafted 3D advertisements, 
Cinema 4D has the advantage of being easy to use and will create amazing results, 
including videos of animations. This could be the only package you ever need to buy. 
 
If you are in architecture, 3DS Max and Lumion may be the only packages you will ever 
need. 
 
However, if price is a concern, you certainly cannot beat Blender. 
 
And now that the issue of ease of use and a more intuitive interface has finally been 
addressed thanks to Blender 2.8,. this free app is poised to become a seriously contender 
and could even knock off Cinema 4D as the preferred 3D package for many users. That is 
why the makers of Cinema 4D have attempted to make its app look more relevant and 
needed in this changing landscape. Priced cheaper than Maya is a start. The other thing to 
give Cinema 4D an advantage is the decision to corner the After Effects market by 
introducing a free Cinema 4D Lite package with every Adobe After Effects sold. With an 
After Effects plug-in created for seamless integration of 3D scenes from Cinema 4D, this 
has helped Maxon considerably to maintain reasonable sales in its more complete Cinema 
4D app once users have become accustomed to the app’s user interface and workflow in the 
Lite version. 
 



But keep in mind the fact that Cinema 4D Lite is limited by the range of editing tools 
available. Furthermore, if you try to save as or export to another file format and use another 
3D package, you will not be able to do this. The C4D file format is proprietary to Maxon. 
No other 3D package is allowed to read C4D files. You will have no choice but to buy the 
full-featured Cinema 4D version, but by then you will have the tools you want. So why 
bother using another 3D package? 
 
As one 3D expert freelancer said: 
 

“That really sucks about cinema 4D for something that has an excellent reputation for 
motion graphics and animation you'd expect it to play well with other software.” 

 
The only thing Cinema 4D Lite will allow is reading other file formats to get the 3D models 
into the C4D environment.1 
 
However, should Blender decide at some point to introduce its own plug-in for After 
Effects and can use the native Blender file format to display the 3D scene and animations 
directly inside After Effects, Maxon will face an incredibly tough time competing with 
Blender. Indeed, if new users had to choose between Blender, which is free, and Cinema 
4D, which already has a hefty price tag, you can be sure where most people will go for in 
the end. 
 
Fortunately, for Maxon, Blender has not yet created a dedicated plug-in for After Effects. 
So the best users can do for now is export Blender file as an obj file format, and consider 
purchasing Elements 3D plug-in to import the objects and manipulate them within After 
Effects. 
 
Never mind. As Blender is quickly reaching a level of power, and now sports a much 
improved user interface, it will soon come down to personal choice and the budgets of 
people to decide which 3D package to use. 
 
So you must either buy and learn Maya because it has been around the longest and has 
provided the necessary features and effects, often ahead of other 3D app makers, or you 
have to choose a cheaper alternative. Choosing Maya makes sense as you know enough 
experts out there are using the same app. Therefore, if you are deciding to enter this 
industry as a 3D specialist and want to help others in achieving certain goals using 3D apps, 
don’t be surprised if you must learn Maya. It will be expected of you to seamlessly work 
with a team of other Maya experts. And that is the way it works. You basically have no 
choice in the matter. 
 
Or you choose Blender for the lowest cost possible and still achieve incredible results. 
 
                                                
1  You can solve this problem by downloading the full version of Cinema 4D and run it as a trial version for 30 days. To repeat this 

trial period in the future if you accidentally create a C4D file or you receive files of this type from others, create and copy for re-use 
a clean Parallels Desktop Windows or macOS virtual disk template to install the software. After conversion, delete the virtual disk, 
and start fresh with another copy of the virtual disk to re-install the app. 



You would only choose a different app priced somewhere between these two extremes 
depending on whether there are other advantages in doing so. Perhaps you would choose 
Cinema 4D if you like the integration with Adobe After Effects and its relatively easy user 
interface. Otherwise, choose the 3D modelling app that does the kind of work you want to 
achieve. 
 
As Blender improves over time, expect a major shake up of the 3D industry in the coming 
years as Blender reaches a level of sophistication and ease of use that will rival the best in 
the commercial world, even Maya.
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The Interface 
 
The interface 
 

 
 
is comprised of: 
 
1. The viewport of a 3D scene showing you a default 3D object called a cube and a large 
mesh-like grid called the plane for helping you to visualize the X, Y and Z directions in 
space: 



 
2. The menus and menu commands provide all the features of Cinema 4D. However, for the 
most common and useful features, the Control tools at the top help with navigating the 
workspace, rotating and scaling 3D objects, creating a standard 3d object to insert in the 
workspace, manipulating and sculpting 3D objects, and, of course, rendering when you are 
finished with your 3D model: 
 

 
 

and on the side for selecting the object, points, edges or polygons of the object, as well as 
helpful tools to make life easier. 

 

 
 



 
3. An animation controls panel/manager: 

 
 
4. The Textures Properties panel/manager: 
 

 
 
5. When you select a 3D object, the Object Properties panel/manager shows additional 
information about the object: 
 

 
 



6. For finer controls, selecting a 3D object will reveal certain attributes that you can control 
and change. 

 
 
 



Opening an existing Cinema 4D model in After Effects 
 
It is a great decision by Adobe to allow Maxxon to provide dedicated 3D functions via its 
Cinema 4D Lite package. The only slight problem is that Cinema 4D will not open unless 
After Effects is open. And even then, it may not be obvious how to open Cinema 4D Lite 
when you see an existing 3D model in the After Effects composition layout. To open 
Cinema 4D Lite, select the file in the Project window of After Effects (it will have the .4d 
file extension). Once selected, press Command (or Ctrl) E, or go under the Edit menu and 
select “Edit Original…”. 
 
Cinema 4D Lite will open. Create a new 4D file and you can quit After Effects if you need 
to. Cinema 4D Lite will stay open. 
 
However, once you purchase the full version of Cinema 4D, you can double-click on the 4D 
file and it will open up in Cinema 4D.



Splitting and Joining the Viewport 
 
By default, you get a single viewport showing you your 3D model. To split the viewport so 
you can see the same 3D objects in different viewports and so help you visualize and 
quickly create 3D models, there is a set of sub-menus in the viewport window pane itself.  
Look for the menu called Panel. From there you can choose the All Views menu command. 
This will split the viewport into a perspective, top, right and front views. Choose 
Panel!Arrangement to arrange the viewports in a preferred way. 
 
To return to single viewport, choose Panel!Arrangement!Single View. 
 

 
 
 

Adding a background image to the viewport 
 
A useful option for recreating, or placing certain 3D objects in position with, a photograph 
or drawing is adding a background image to the viewport. 
 

1.! You need to lock in the camera view if you want to see the background image or 
photograph. So add a camera by clicking on  



 

 
 

2. In the full version of Cinema 4D, click the sub-menu Tags in the Object Manager’s 
properties panel. Choose Tags!CINEMA 4D Tags!Camera Calibrating. The aim 
here is to set the 3D workspace grid perspective to match the image or photograph. 
And it is also the place you add an image or photograph to the background. 

3.! Click the Image tab. 
 

 
 

4.! Add your image or photograph by clicking the “…” button on the right next to Image. 
5.! Make adjustments to the image as needed below the image file path. The most 

common areas of adjustment are made in Film Aspect, Image Scale and Offset, and 
Brightness. 

6.! Click Calibrate tab followed by the Add Grid button. A grid will appear in the 
viewport. Adjustment the grid to match the perspective of the background image or 
photo. 

7.! You need to tell Cinema 4D where the X, Y and Z axis of the grid is located. Click 
the Grid to select it. Then press Shift and click again, and again, until you have the 
correct orientation of the axes. 

8.! Look through the camera. 3D workspace matches the grid’s perspective. 
9.! Add 3D objects. Moving the objects will automatically scale to match the 

perspective. 
 
 

Are you in object or edit mode? 
 
The next crucial step is knowing whether you are in Edit or Model (Object) mode. 



 
When you create a new standard 3D model, such as a cube or sphere, you are automatically 
in Model mode.
 
Prior to going into Edit mode, consider increasing the number of polygons on the surface of 
the 3D object. In this way, you can manipulate the 3D object in sophisticated ways using 
other tools. 
 
For a cube, look in the Attributes panel and click the Object tab. You will see Segments X, 
Segments Y and Segments Z for the X, Y and Z planes. Put a number greater than 1 in one 
or more of these planes. 
 

 
 
Segmenting also exist for a sphere and other standard 3D object. 
 
When you are ready to manipulate the object, click the Edit mode button: 
 

 
 
You are now ready to select points, edges or polygons, and apply various sculpt and shape 
tools to your selected 3D object. You can also apply tools to scale, rotate and move while in 
Edit mode. If you ever need to select the entire object, click: 



 

 
 
To select a polygon, press: 
 

  
 
The two buttons above this will allow you to select a point or line. 
 
In Cinema 4D, there is no switching back to Model mode once you have entered Edit mode. 
What you do is select the entire object by clicking: 
 

 
 


